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Foreword E



veryone will tell you the top concern among CIOs and IT professionals continues to be simplification and optimization of business processes. Couple that with the increasing need to reduce IT operating costs and integrate line-of-business applications and disparate data sources, and you quickly peel back the covers of a complex issue facing mid-market and enterprise customers. This is the challenge many IT staff and system integrators face each day as they attempt to deliver business value to the organizations they serve. The good news is that more than 1300 professional service firms around the globe have realized Microsoft BizTalk Server is an ideal tool to help address these imperatives. Microsoft BizTalk Server 2006 enables businesses to optimize operations through automation and the exposure of processes and data in real time. It also provides simple yet powerful tools to gain a real-time understanding of business processes. Microsoft BizTalk Server helps you to grow your business and drive efficiency. With over 15 years combined practical, hands-on customer experience, the authors of BizTalk 2006 Recipes have created a powerful reference for realizing the benefits of Microsoft BizTalk Server 2006. Each problem is presented with a practical, proven solution followed by a discussion of alternatives, considerations, and best practices. This book is ideal for consultants and staff who are seeking quicker return on investment and certain business value. Additionally, you will find comprehensive guidance on working through the most complex deployment challenges, including tested, reusable code snippets for use in production, enabling faster deployment and minimal post-implementation engineering support. Most will agree there is no substitute for training at the school of hard knocks. However, this book should help mitigate and prevent failed deployments. Be sure to apply the lessons learned within its covers every day. Do not leave this in your car, office, or bag. Robert Bannerman Partner Strategy Manager Microsoft Corporation
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Introduction E



nterprise integration is a complex problem. Even with an exceptional product like BizTalk Server 2006, many variables and considerations contribute to the enterprise integration puzzle. Each of this book’s authors has worked with BizTalk since the product’s inception in the early 2000s and has implemented more than ten enterprise integration projects during his IT professional consultant career. Many books on the market provide solutions without context to the problem. BizTalk 2006 Recipes: A Problem-Solution Approach aims to not only give the reader solutions to common BizTalk integration scenarios, but also to provide the reader with information related to the problem at hand. By handpicking the key scenarios, we hope to arm the reader with sufficient information to make the best decision when faced with enterprise integration challenges.



Book Requirements The recipes in this book are intended to be hands-on exercises, introducing developers and administrators to the different BizTalk Server 2006 components. Given the activity-based nature of this book, it is essential to have a working environment with the following components: • BizTalk Server 2006 (and all prerequisites; see installation instructions) • SQL Server 2005 or 2000 • Visual Studio 2005 The majority of developers will be working with BizTalk Server, SQL Server, and Visual Studio on a single platform. Based on this, Microsoft lists the following recommended minimum requirements for the system: • 1GHz or higher (single processor) • 1GB of RAM • 6GB hard disk space • Super VGA (1024 ✕ 768) resolution monitor System requirements for BizTalk Server 2006 are highly dependent on the nature of the solutions that will be implemented. For instance, a solution that may be installed on multiple BizTalk and SQL Server database servers could require a substantially different configuration than a single server with both BizTalk and SQL Server installed. Additionally, small solutions with very low processing needs (a few simple orchestrations a day) will require far fewer system resources than a complex solution that is processing large batches throughout the day. A common approach to setting up enterprise systems is to obtain a server with as much processing power as possible, including multiple CPUs and expansive disk space. However,
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this paradigm frequently should be altered in the integration space, especially as it relates to BizTalk. Often, the appropriate approach is to decrease the number of CPUs on a single box and spread them across multiple boxes (for example, four BizTalk servers with one CPU each are often preferable to one BizTalk server with four CPUs), increase the RAM, and ignore the disk space (BizTalk solutions are often extremely small). By scaling out instead of scaling up, many BizTalk solutions will operate more efficiently, sharing resources between boxes within a BizTalk group as needed. Additionally, licensing and hardware costs can be reduced. As you work through the recipes in this book, and begin to build and deploy BizTalk solutions for production environments, you will learn to assess what type of server configurations are most appropriate. Because BizTalk crosses multiple environments, from application servers and Internet Information Services (IIS) servers to SQL database servers, it is important to speak with the administrators of each environment to make sure the systems are set up properly and operating correctly.



Who This Book Is For The recipes in this book are intended for a diverse audience. Whether you are just picking up the product for the first time and don’t know what a schema is or you are a seasoned BizTalk professional looking for the latest patterns, this book has something to offer you. Unlike traditional cover-to-cover books, the recipe format lends itself to problem-solving. Recipes are organized by problem statements that help you quickly identify solutions to common BizTalk scenarios. For this reason, we suggest that you keep a copy of this book next to your workstation as a reference.



How This Book Is Organized This book is made up of the following ten chapters: Chapter 1, Document Schemas: The foundations of all BizTalk solutions are schemas— documents that define how messages are structured and accessed within BizTalk Server. Understanding schemas is essential to the successful creation of maps and orchestrations, and the correct routing of messages through the messaging system. Proper design and construction of schemas will reduce the need for substantial rewrites of orchestrations and other dependent components later in the development cycle. The aim of this chapter is to introduce key concepts of working with schemas and to provide the developer with enough information to make the appropriate decisions related to the development of this essential building block. Chapter 2, Document Mapping: As data is passed between systems, one core need is always present: to define how data maps from one system to the next. BizTalk provides extensive options for mapping, including a graphical user interface to create maps, preexisting functoids that provide standard mapping functions, the ability to create custom code for advanced mapping requirements, access to pure XSLT for advanced programmers, and powerful XPath functionality for accessing nodes and allowing for alternative mapping methods. This chapter provides numerous recipes to help developers build and test both simple and complex maps.
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Chapter 3, Messaging: The BizTalk Server engine is built on messaging—the movement of documents in, through, and out of the system. Messaging allows documents to be routed to subscribers (external systems or internal orchestrations) through ports and pipelines. This chapter describes the methods necessary for routing messages, working with these messages in memory, and performing operations on messages that are outside orchestrations. Chapter 4, Orchestration: The core of BizTalk processing lies in orchestrations. Multiple thread handling (parallel shapes), synchronous and asynchronous responses (send, receive, and listen shapes), proper exception handling (scope shapes and error-handling patterns), and notifications in the case of failure are highly valuable components of an integration engine, and all of these are available in BizTalk orchestrations. This chapter presents extensive examples for orchestration development and provides detailed discussions to help developers design and build viable solutions. Chapter 5, Business Rules Framework: Organizations may need to process information differently depending on the data submitted. In the case of BizTalk, information is submitted via a message, and data within that message may require special processing once it has been received by an orchestration. The orchestration must be able to determine what that data is and how to process it. Additionally, rules around how that data is interpreted may change at any given time, even after the solution is in production. For example, a rule may be required that allows processing messages as long as a specific field has a value less than 10, but must stop processing and notify an administrator when this value is equal to or exceeds 10. The ability to store and access such a rule and to make it available for customization through a user-friendly interface is provided by the BizTalk business rules framework. Chapter 6, Adapters: Adapters are the first point of contact between BizTalk Server and outside systems and provide the functionality necessary to turn incoming data into a message with which the messaging engine can work. Data is often delivered to and from systems in several standard formats, including file transfers, HTTP posts, web services, and SQL calls. BizTalk provides these transport mechanisms through the standard adapters, with interfaces that allow for highly configurable implementations. In situations that require an approach that is not provided for in the standard adapters, custom adapters can be written and deployed. This chapter demonstrates the use of standard adapters for a variety of applications, and introduces the concepts necessary for writing custom adapters when the need arises. Chapter 7, Deployment: The process of deployment to a production environment can be challenging for any type of solution, but integration solutions are complicated by the number of systems that may be impacted, as well as the number of different components that may be required. BizTalk Server provides a large number of options for deployments, from simple manual installations to all-inclusive MSI packages. This chapter provides recipes that introduce the key tools and concepts used for deploying BizTalk solutions.
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Chapter 8, Administration and Operations: Once solutions have been deployed to a production environment, numerous administrative practices are required, including standard maintenance (database backups and data cleanup), issue tracking (determining where a message is in a given process), load considerations (ensuring that the BizTalk Server environment is configured and scaled properly, and that it is using its system resources properly), and other general tasks. This chapter walks through the different tools that are available for administering BizTalk Server and viewing data that is being (or has been) processed. Chapter 9, Business Activity Monitoring: Once processes are deployed and executing, it is often essential to view statistics about these processes. Business analysts may need to see metrics about how long it takes for a certain orchestration to complete, while a system administrator may need to know the number of instances that occur of a specific orchestration between the hours of 8 AM and 5 PM. Business Activity Monitor (BAM) provides the engine necessary to access this type of information in BizTalk Server and the tools with which to view it. This chapter explores the options available for developing and deploying BAM solutions. Chapter 10, Encore: BizTalk Server 2006: This chapter provides recipes for additional advanced techniques pertaining to BizTalk Server 2006.



7117Ch01



8/29/06



3:33 PM



Page 1



CHAPTER



1



■■■



Document Schemas T



he BizTalk tool set enables exchanging information among computer systems. Each area of BizTalk’s rich set of capabilities addresses the common development tasks of building an integration solution. For example, BizTalk has tools for the common task of translating information from a structure understood by a source computer system into a structure understood by a destination computer system. Other BizTalk tools focus on defining integration processes, or patterns of information flows. This chapter focuses on the capabilities of the BizTalk Editor tool. The BizTalk product team designed the Editor tool specifically for defining the structure of the information that flows through BizTalk. BizTalk calls these definitions schemas, and the BizTalk Editor creates them. For example, suppose a customer message flows through BizTalk. This message may contain customer demographic information such as occupation and gender, logistical information such as address, and information about the particular products of interest to the customer. BizTalk needs to collect and organize this information in a structured format to fully utilize it. Sometimes BizTalk needs to examine messages to handle them correctly. For example, suppose additional verification steps are needed if a customer’s purchase is very expensive and outside his normal buying patterns. A BizTalk schema can promote the purchase amount and make it available throughout BizTalk. BizTalk can examine the purchase amount and take an additional step to send a notification message to the customer’s representative. This property promotion process creates a property schema defining information about the message. The BizTalk runtime engine uses property schemas extensively, capturing information such as the location where BizTalk accepts a message or the message’s intended destination. XML standards form the core of BizTalk. At no time is this more evident than when defining messages with the BizTalk Editor development tool. Use the Editor to define the structure of information. For example, you can create a hierarchy in which a customer message contains a demographic section, an address section, and a section for customer preferences. Each of these sections can contain details relevant only to that section. The XML Schema Definition (XSD) language natively defines message structure to BizTalk. Since the Editor defines messages in XSD by default, any XSD-compliant XML editor can define BizTalk messages. However, the BizTalk Editor supports many of the rich capabilities of XSD, such as importing common schemas to facilitate reuse and consistency across message formats. In addition to message structure, the BizTalk Editor can also define the data types of specific fields, thus completing the message definition. These data type definitions can be interoperable XSD primitive types, such as xs:string or xs:decimal, or complex data types.



1



7117Ch01



2



8/29/06



3:33 PM



Page 2



CHAPTER 1 ■ DOCUMENT SCHEMAS



For example, complex types may require values adhering to regular expressions or a list of enumerated values enforced with the schema. Finally, while XML standards are the core for BizTalk messages and the Editor, a message structure can extend beyond XML to apply to other formats such as a comma-delimited flat file representation. BizTalk can efficiently parse a diverse population of message formats into XML for processing within the core BizTalk runtime engine. XML must still define the message structure and fields, but a schema can specify additional information defining how the XML message translates to and from the file format.



1-1. Creating Simple Document Schemas Problem As part of your business process or messaging solution, you need to create a simple XML schema.



Solution The following steps outline how to create a simple schema and add it to your BizTalk project. 1. Open an existing project or create a new project in Visual Studio. 2. As shown in Figure 1-1, right-click the project name in the Solution Explorer and select Add ➤ Add New Item (alternatively, select File ➤ Add New Item).



Figure 1-1. Adding an item from the Solution Explorer



7117Ch01



8/29/06



3:33 PM



Page 3



CHAPTER 1 ■ DOCUMENT SCHEMAS



3. The Add New Item dialog box will appear, as shown in Figure 1-2. Select Schema as the type of item, type in a name for the item, and click OK.



Figure 1-2. Add New Item dialog box 4. Right-click the Root node and select Rename. Then change the name of the node. 5. To add nodes, right-click a node and select Insert Schema Nodes. Then select from the following options, as shown in Figure 1-3: • Child Record, to add a new record node indented one level from the selected node • Child Field Attribute, to add a new attribute node indented one level from the selected node • Child Field Element, to add a new element node indented one level from the selected node • Sibling Record, to add a new record node at the same level of the selected node • Sibling Field Attribute, to add a new attribute node at the same level of the selected node • Sibling Field Element, to add a new element node at the same level of the selected node



3



7117Ch01



4



8/29/06



3:33 PM



Page 4



CHAPTER 1 ■ DOCUMENT SCHEMAS



Figure 1-3. Adding schema nodes 6. Select a node to view and modify its properties. 7. Build and deploy the solution.



How It Works XML schemas are the foundation of all scenarios and document exchanges with BizTalk Server. Once you have created your schema, you can create your scenario. Whether it is a pure messaging solution or involves business process automation scenarios implemented as orchestrations (covered in Chapter 4), the schema is available to all other projects and solutions simply by referencing it. Additionally, once you have created your schema, you can generate instances of the document that will adhere to the schema definition. This feature makes it very easy to create test data. To generate a test instance, follow these steps: 1. Open the schema Property Pages dialog box, shown in Figure 1-4, by right-clicking the schema name in the Solution Explorer and selecting Properties.



Figure 1-4. Schema Property Pages dialog box
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2. Type in a path and file name next to Output Instance Filename, or select the ellipsis to use the common file dialog box to browse to a file location and name the file. Then click OK. 3. Right-click the schema and select Generate Instance. A test instance of the document will be created, located, and named based on the Output Instance Filename property specified. Similarly, BizTalk Server provides the ability to validate that an instance of a document adheres to a schema definition. To validate an instance, follow these steps: 1. Open the schema Property Pages dialog box by right-clicking the schema name in the Solution Explorer and selecting Properties. 2. Type in a path and file name next to Input Instance Filename, or select the ellipsis to use the common file dialog box to browse to a file location and select a file. Then click OK. 3. Right-click the schema and select Validate Instance. The document specified in the Input Instance Filename property will be validated against the schema.



1-2. Creating Schema Namespaces Problem You have two schemas that need to be represented with the same root node.



Solution BizTalk Server uses a combination of namespaces and root nodes to resolve schema references. Therefore, it is possible to have two schemas with the same root node as long as their namespace designation is different. By default, the BizTalk Editor will set the namespace of a schema to http://[solution].[schema], where solution refers to the name of the solution file and schema refers to the name of the schema file. This default namespace designation may be modified as follows: 1. Open the project that contains the schema. 2. Double-click the schema to open it. 3. Select the node. 4. Right-click and select Properties. 5. Modify the Target Namespace property as desired. When you modify the Target Namespace property, BizTalk Server will automatically modify the Default Namespace (element name xmlns) of the schema to match the Target Namespace. Once the two schemas with the same root node have different namespace designations, they may be used without any conflicts.
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How It Works Namespaces are used to allow elements and attributes from different schemas to share names. For example, two schemas may have an element named FirstName. If the schemas did not have different namespaces, BizTalk Server would not know which FirstName you were referencing. As well as adopting naming standards and conventions for all BizTalk artifacts, you should adopt a standard for namespaces in schemas. An example of a standard is as follows: http://[Company Name].[Project].BizTalk.Schemas.[Schema].[Version] where Company Name is your company name, Project is the name of the project, Schema is the name of the schema, and Version is the version number of the schema. In summary, BizTalk Server can accommodate two or more schemas with the same root node as long as the schemas have unique namespace designations.



1-3. Promoting Properties Problem You have a scenario where you want to subscribe to a message differently based on the contents or context of the message, and you need to understand how BizTalk Server exposes this metadata.



Solution In order to promote instance-specific data fields (data that resides in the actual message instances, such as a customer name or the ID of an order), you must create a property schema. You then promote the specific schema elements, attributes, or records you need to subscribe to into the property schema. This task is accomplished in Visual Studio, and can be done in one of two ways: quick promotion and regular promotion. For more information on both of these methods, see Recipe 1-4, which describes how to create a property schema. In addition to instance-specific data fields, a number of system- or exchange-specific properties are automatically promoted by BizTalk Server. A description of these exchangespecific properties, and the fundamental difference between them and instance-specific properties, is provided in the following “How It Works” section. All properties that have been promoted, regardless of whether they are associated with a specific instance or the message exchange in general, are available for subscription by other BizTalk Server objects, including send ports, send port groups, and orchestrations. Promoted properties are also available for tracking purposes, which allow them to be used in troubleshooting and reporting.



How It Works The importance of promoted properties in BizTalk Server’s publish/subscribe architecture cannot be overstated. Understanding how they work is absolutely critical when designing and building an integration solution. From a simplistic perspective, a publish/subscribe integration architecture involves source systems publishing or outputting messages to a centralized hub. After the hub receives these messages, it delivers them to the destination, or subscribing, systems. Within BizTalk
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Server, promoted properties are the key data that determine which messages are delivered to subscribing systems or processes. Without promoted properties, messages would be received by BizTalk Server, but they would not be sent out, resulting in a sort of black hole of messages. This would obviously not be a good situation, and BizTalk Server will actually throw an error if a message is received without having a system or process that subscribes to it. This keeps with the theory that it is not a good idea for a publish/subscribe integration hub to accept messages for which it does not have a subscriber. A term that is commonly used to describe a message’s promoted properties is message context. Message context includes all the instance-specific and exchange-specific data fields, and essentially is the metadata that the messaging engine of BizTalk Server uses to process messages. As previously noted, instance-specific properties are those that pertain to a specific message instance, and they must be promoted explicitly during development. A common example of this type of property is an XML element containing a unique ID, which may capture an important data field such as an order number. From a message schema, XML elements, attributes, and records may be promoted.



■Note In order for an XML record to be promoted, its ContentType property must be set to SimpleContent. All promoted properties, regardless of whether they are populated by XML elements,



attributes, or records, have a maximum length of 255 characters.



Along with being the key data elements allowing message subscription, promoted properties are also commonly used in orchestrations to determine business process. Orchestrations can handle messages dynamically by interrogating promoted properties that hold key metadata elements of a message. For example, sales orders being delivered domestically may need to be handled differently than those being sent overseas. By capturing the destination country of an order in the document schema, and flagging the element as a promoted property, this data element can easily be used as a decision point in the orchestration. Domestic orders could be handled on one branch of decision logic, and international orders handled on another. It is important to note here that as an alternative to using promoted properties, the actual XML message could be interrogated within the orchestration to determine the destination of a sales order. While this method could be used, leveraging promoted properties simplifies programming and has performance benefits, as promoted properties can be accessed directly without incurring the cost of opening the entire XML message. For additional performance gains, distinguished fields can be used as opposed to promoted properties within orchestrations. Distinguished fields provide functionality similar to promoted properties (allowing access to instance- or exchange-specific metadata items on a message), with a few key differences: • Distinguished fields are available only within a single orchestration instance, and they are not available to other BizTalk Server objects, such as receive locations, send ports, send port groups, and tracking utilities. • Distinguished fields can be of any length; promoted properties have a maximum length of 255 characters.
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• Distinguished fields have less of a performance impact than promoted properties, as they are not persisted to the MessageBox database. Instead, they are essentially XPath aliases, which simply point to the appropriate XML data field. Additionally, adding the DistinguishedField attribute to a field on a .NET class allows it to be exposed as a distinguished field. • Distinguished fields are accessed through a reference to the name of the message, the name of the record structure containing the distinguished field (which could include multiple levels of child records), and the name of the distinguished field, with each named item separated by periods: MessageName.RecordName.ChildRecordName. DistinguishedFieldName. Promoted properties, on the other hand, are accessed through a reference to the name of the message, the name of the property schema, and a name of the promoted property, via the following format: MessageName(PropertySchemaName.PromotedPropertyName). Certain scenarios will call for sensitive information, such as a bank account number, to be used as a promoted property. To allow for enhanced troubleshooting and detailed reporting, promoted properties can be viewed in tools such as Health and Activity Tracking (HAT) and Business Activity Monitor (BAM). Based on privacy regulations, these data fields may need to be hidden from these tools, which can be accomplished by setting the promoted property’s Sensitive Information property to True (this configuration is applied on the property schema). System- or exchange-specific properties are those that are automatically promoted by BizTalk Server, and allow the successful processing of those documents by the messaging engine. The fundamental difference between the two types of properties is that exchangespecific properties can all be determined without looking into the actual contents, or payload of the message. Instance-specific properties, on the other hand, are all populated with actual values within a message instance. Exchange-specific properties come in various types. Table 1-1 lists the default exchangespecific property types that come with a complete installation of BizTalk Server. Additional properties may be added as other BizTalk-related items are installed, such as the MQ Series adapter. Table 1-1. Default Exchange-Specific Property Types



Type



Description



BizTalk Framework (BTF2)



Properties that support the BizTalk Framework



BizTalk Server (BTS)



Properties that support core BizTalk Server messaging



Error Reporting (ErrorReport)



Properties that support error reporting and handling



File Adapter (File)



Properties that support the File adapter



FTP Adapter (FTP)



Properties that support the FTP adapter



HTTP Adapter (HTTP)



Properties that support the HTTP adapter



Legacy (LEGACY)



Properties that support BizTalk Server 2002 properties



Message Tracking (MessageTracking)



Properties that support message tracking



HWS (Microsoft.BizTalk.Hws)



Properties that support Human Workflow Services



Orchestration (Microsoft.BizTalk. XLANGs.BTXEngine)



Properties that support the BizTalk Server orchestration engine
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Type



Description



MIME (MIME)



Properties that support the processing of MIME-encoded messages



MSMQT Adapter (MSMQT)



Properties that support the MSMQT adapter



POP3 Adapter (POP3)



Properties that support the POP3 adapter



SMTP Adapter (SMTP)



Properties that support the SMTP adapter



SOAP Adapter (SOAP)



Properties that support the SOAP adapter



Windows Sharepoint Services Adapter (WSS)



Properties that support the WSS adapter



XML Document (XMLNorm)



Properties that support the processing of XML documents



BizTalk Server processes promoted properties as messages are received into or sent out of the MessageBox. Specifically, pipelines handle this task. System- or exchange-specific properties are promoted by default, through pipelines such as XML or PassThru (both the receive and send variety). For instance-specific properties to be promoted, a pipeline other than the PassThru must be used, as this pipeline does not attempt to match messages to their associated schemas (and therefore property schemas). As properties are promoted, their XSD data types are converted to Common Language Runtime (CLR) data types. Table 1-2 shows XSD data types and their associated CLR data types. Table 1-2. XSD Data Types and Associated CLR Data Types



XSD



CLR



XSD



CLR



anyURI



String



Name



String



Boolean



Boolean



NCName



String



byte



sbyte



negativeInteger



Decimal



date



DateTime



NMTOKEN



String



dateTime



DateTime



nonNegativeInteger



Decimal



decimal



Decimal



nonPositiveInteger



Decimal



double



Double



normalizedString



String



ENTITY



String



NOTATION



String



float



Single



positiveInteger



Decimal



gDay



DateTime



QName



String



gMonth



DateTime



short



Int16



gMonthDay



DateTime



string



String



ID



String



time



DateTime



IDREF



String



token



String



int



Int32



unsignedByte



Byte



integer



Decimal



unsignedInt



Uint32



language



String



unsignedShort



Uint16
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In addition to pipelines, orchestrations may also be used to explicitly set promoted properties. This is important if your business process requires the copying or creation of messages. Since messages are immutable (meaning once a message has been created, it cannot be modified) in BizTalk Server, a new message must be created prior to any of its promoted properties being set. When a message in constructed in an orchestration as a copy of another message, the message context (its promoted properties), by default, are all copied to the new message. Once this new message is created, its properties may be explicitly set to something different than in the original message. This must be done in the same Message Assignment shape in the orchestration as the duplicate message.



■Note When a copy of a message is created in an orchestration, it is important to consider how the properties on the original message are configured. If any of its properties are configured to use MessageContextPropertyBase for the Property Schema Base (a property of the promoted field found in the property schema), they will not be copied to the new message in the orchestration. By contrast, all those properties that are configured to use the MessageDataPropertyBase (the default value) for the Property Schema Base will be copied to the new message. For more information about the Property Schema Base property, see Recipe 1-4.



1-4. Creating Property Schemas Problem You want to subscribe to a message based on the contents of the message.



Solution Property schemas allow you to promote properties so that they can be used when setting up filter expressions. As long as the PassThruReceive pipeline is not used, these promoted properties are added to the message context during pipeline processing. Once added to the message context, they can be used as filter expressions on send ports. These properties are also available to be evaluated or modified in orchestrations. To create a property schema and promote a property, follow these steps: 1. Open the project that contains the schema. 2. Double-click to open the schema. 3. Select the node that you wish to promote. 4. Right-click and select Promote ➤ Quick Promotion, as shown in Figure 1-5.
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Figure 1-5. Completing a quick promotion of a property 5. You will be asked if you wish to add the property schema to the project. Click OK. The property schema is created with a reference to the promoted property, as well as a default property of Property1. This may be removed from the property schema.



■Note You may also add a property schema by highlighting the project in the Solution Explorer and selecting Add ➤ Add New Item ➤ Property Schema. Once the property schema is added to the project, you must associate it with a schema. To do this, select the schema in the Solution Explorer, right-click a node in the schema, and select Promote ➤ Show Promotions. In the dialog box, select the Property Fields tab and click the Folder icon to launch the BizTalk Type Picker dialog box. Browse to the property schema, select it, and click OK.



6. To view all promoted properties, select any node in the schema and select Promote ➤ Show Promotions to open the Promote Properties dialog box. 7. Select the Property Fields tab to view all of the promoted properties, as shown in Figure 1-6. 8. You may promote additional fields directly from this dialog box, or repeat steps 3 and 4 to promote other fields. 9. Build and deploy the solution.
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Figure 1-6. Viewing the promoted properties in the Promote Properties dialog box



How It Works Once you have deployed the solution with the promoted properties, they may be used to perform content-based routing on the documents. Following is a simple example of contentbased routing. Assume you have the following two documents: John Doe 1979-05-31 Washington Sam Evans 1973-03-15 California You would like to send each of these documents to a different destination based on the StateOfBirth field. After creating a simple schema to represent these documents, the StateOfBirth element is promoted using the steps outlined in the “Solution” section. Once the
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project is built and deployed, you are able to reference the promoted property when creating a send port filter expression. In this example, two distinct send ports are created. Figure 1-7 shows the filter expression on the first send port. The subscription is based on the value of the StateOfBirth field being equal to Washington.



Figure 1-7. Subscription for Washington On the second send port, the subscription is based on the value of the StateOfBirth field being equal to California, as shown in Figure 1-8.



Figure 1-8. Subscription for California
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Although this example is simple, it is easy to see how you can leverage this feature to create content-based routing scenarios through the use of promoted properties. It is also possible to create message context properties that do not exist in the message itself, but only in the message context. This may be valuable when you are not allowed to modify the schema, but would like to associate additional information with the document. This may be accomplished by adding a node to a property schema and setting its Property Schema Base property to MessageContextPropertyBase. This property is then available and can be set in an orchestration, and ultimately the document may be routed based on its value. For example, perhaps you would like to calculate the age for each person processed in the preceding example, but you cannot add an Age element to the schema. As opposed to adding a node to the schema, a node is added to the property schema, as shown in Figure 1-9.



Figure 1-9. Adding a property to message context After building and redeploying the solution, a second property, Age, is now available for generating filter expressions. To complete the scenario, you would do the following: • Create an orchestration that subscribes to all of the documents with no value for Age. • In this orchestration, calculate the Age value based on the birth date and set the property accordingly.
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• Send the document back into the MessageBox. • Add a second filter expression to the existing send ports to subscribe based on the StateOfBirth and if the Age value is present. In summary, content-based routing is a typical scenario, and property schemas are used to extend the message context properties that come with BizTalk Server.



1-5. Importing Schemas Problem You would like to import an existing XML schema into another schema.



Solution You can use the XSD Import method within the BizTalk Editor to reuse an existing common XML object structure within another, as opposed to manually creating an entire schema. As an example, assume you have two simple XML structures, Customer and Address: To use the XSD Import method to allow this scenario within BizTalk, follow these steps: 1. Open the project that contains the schema. 2. Double-click the Customer schema to open it. The schema is shown in Figure 1-10. 3. Click the root node of the Customer schema. 4. In the Properties window, within the Advanced group, click the ellipsis next to Imports to open the Imports dialog box, as shown in Figure 1-11.
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Figure 1-10. Customer schema



Figure 1-11. Imports dialog box
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5. Select XSD Import as the import type and click the Add button. 6. In the BizTalk Type Picker dialog box, select the Schemas tree node and select the Address schema, as shown in Figure 1-12.



■Note In this example, the Address schema is within the current BizTalk project. If the schema existed outside the BizTalk project, the schema could be imported by selecting the Reference tree node.



The preceding procedure imports the Address schema into the Customer schema. To use the Address schema, follow these steps: 1. Click the Customer node in the Customer schema. 2. Right-click and select Insert Child Record. 3. Click the newly created child record. 4. In the Properties window, within the General group, click the Data Structure Type drop-down list and select the Address reference, as shown in Figure 1-13. The Customer schema is now referencing and using the Address schema via the Imports schema method within the BizTalk tool set.



Figure 1-12. Selecting a schema to import
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Figure 1-13. Selecting the Address object reference



How It Works Within the BizTalk tool set, there are a variety of ways in which you can construct XML schema. The choices revolve around common architecture principles such as reuse, development best practices for schema organization, and fundamental development preferences. This example illustrated using the Imports method for referencing schema. The Imports dialog box (Figure 1-12) offers three choices for achieving the schema reference activity (step 5 of the recipe): Include: This method physically includes a schema definition within another. The common usage would be to create a static reference of a schema during the schema build process. This choice could be used to leverage previously defined XSD schema (for example, publicly available schema). The include schema must be the same target namespace of the schema you are including. Alternatively, the target namespace of the include schema can be blank. Import: The most commonly used import method within BizTalk, the Import option includes XSD Imports statements within the source schema definition. By using this option, namespaces and XSD object structures within the target schema are available for use within the source schema in read-only fashion. The practical application for this choice revolves around common reuse, such as reuse of an existing schema artifact or use of a publicly available XML schema. Redefine: The least-common import method within BizTalk, the Redefine option, like the Import option, allows namespaces and XSD object references to be used within the source definition. However, the Redefine option allows objects and data structures to be overridden within the source definition. Common uses could be to create an inheritance model or to reuse and customize an existing XSD structure. This example demonstrated referencing other schemas within the BizTalk tool set. However, while BizTalk provides and implements standard XSD instructions to achieve this functionality, common architecture usage and choices should not be ignored to ensure the correct schema reference method is selected.
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1-6. Referencing Schemas Problem You would like to reference an XML schema in your BizTalk project, perhaps because you want to reuse an existing BizTalk artifact or prebuilt schema component.



Solution As an example, assume you have a simple Customer XML schema (CustomerSchema.dll) stored in an existing BizTalk project: To reference an existing schema, follow these steps: 1. Open your source project. 2. Within the Solution Explorer, right-click the References tree node and select Add Reference. 3. Select the Projects tab in the Add References dialog box. 4. Click the Browse button, navigate to CustomerSchema.dll, and then click the Open button. You now have referenced CustomerSchema.dll and can use the inherent BizTalk artifacts in your current project. For example, suppose that you want to use the DLL in a new map within your current project. Follow these steps: 1. Right-click the project and select Add ➤ New Item. 2. In the Add New Item dialog box, double-click Map. This opens a blank map with left and right panes where you can enter the source and destination schema, respectively. 3. Click Open Source Schema in the left pane. 4. In the BizTalk Type Picker dialog box, select the References tree node and select the Client Schema reference. 5. Select the Schemas node. 6. Select the Customer schema, as shown in Figure 1-14.
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Figure 1-14. Selecting a schema to reference



How It Works Referencing schemas gives you the ability to reuse and reference existing BizTalk artifacts, as you would normally reference other .NET artifacts. While this can be powerful, you should always keep in mind partitioning and change scenarios. For example, if you were to reference an existing deployed artifact, to make changes to the referenced artifact, you would need to remove the referenced artifact in the dependent project. This example explored how to reference a schema artifact in another project. BizTalk also gives you the ability to reference schemas in Schema Import tasks. For information on how to import schema references, refer to Recipe 1-5.



1-7. Creating Envelopes Problem You are receiving a message that contains multiple records in a batch fashion. In order to import this information into the appropriate systems, each record must be handled individually, as opposed to processing them all in a single batch.



Solution Envelopes allow you to define a container schema that wraps a number of child schemas or subschemas. By defining which child records it contains, the envelope allows BizTalk Server to access the subrecords individually (a process commonly known as debatching) and process them as distinct messages. For this solution, it is assumed that the schema defining the child record has already been created (see Recipe 1-1). To create an envelope schema, follow these steps:
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1. Open the project that contains the child record schema. 2. Right-click the project and select Add ➤ Add New Item to open the Add New Item dialog box. 3. Select Schema Files from the BizTalk Project Items category and Schema from the list of templates. Enter a descriptive name for your new schema, as shown in Figure 1-15. Then click Add.



Figure 1-15. Adding a new schema to a project 4. Right-click the Root node of the new schema, and change it to the root name of the incoming schema containing the batch of records (OrderEnvelope in this example). 5. Click the Schema node (directly above the newly renamed root node) and change the Envelope property of the schema to Yes (in the Properties window), as shown in Figure 1-16. 6. Right-click the newly renamed root node and select Insert Schema Node ➤ Child Record, Child Field Attribute, or Child Field Element, to add the appropriate envelope elements. In this example, a child field element named BatchID and a child record named Orders, which will contain the child records, are added. 7. Right-click the record that will contain the child records (Orders in this example) and select Insert Schema Node ➤ Child Record to add a container for the child records. In this example, a child record named Order is added.
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Figure 1-16. Configuring the schema to be an envelope 8. Right-click the container child record (Order in this example) and select Insert Schema Node ➤ Any Element to add a placeholder for the child elements. The resulting envelope schema has the structure shown in Figure 1-17.
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Figure 1-17. Envelope schema structure 9. Click the root node (OrderEnvelope in this example) and click the Body XPath property of the schema (in the Properties window), which will open the Body XPath dialog box. 10. Navigate down through the schema structure displayed in the tree view and select the container record for the child records you wish to process individually (the Orders record in this example), as shown in Figure 1-18. Then click OK. 11. Build and deploy the solution.
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Figure 1-18. Specifying a child record



How It Works Envelopes provide the means to group multiple messages into one XML document. In the preceding example, the envelope was used to disassemble individual order documents from a single enveloped document containing a batch of orders. Once the envelope and document schemas (OrderEnvelope and Order in the example) have been deployed, BizTalk Server has the ability to leverage the two in message processing. The following XML represents one possible instance of the envelope schema: BatchID_0 1 1.00 2 2.00 When passed through an XML disassembler pipeline component in BizTalk Server, the preceding XML message will produce the following two XML documents, which can be processed individually:
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1 1.00 2 2.00 As these order documents are split up into separate messages within BizTalk Server, they can undergo different forms of business logic or be delivered to a different destination, depending on their properties (see Recipe 1-3 for more information about property-based subscriptions). The key data element that allows envelope processing in BizTalk server is the Body XPath property. This data element acts as a pointer to the container record that encapsulates or surrounds the child records. On the OrderEnvelope root node, the Body XPath property was set to the Orders record, which contains the individual Order records. In envelope schemas containing a single root node, the Body XPath property must be set to that root node. For envelope schemas with multiple root nodes, the following apply: • If the Root Reference property is not set on the envelope schema, the Body XPath property must be set for all root nodes. • If the Root Reference property is set on the envelope schema, the Body XPath property must be set for the root node configured in the Root Reference property. The Body XPath property can be set for the other root nodes, but it is not required. • It is not required to set the Root Reference property, but the Body XPath property must always be set on at least one root node. In addition to encapsulating multiple messages, envelopes can also supply header information that applies to all the records it contains. In the example, the BatchID element is defined once at the envelope level, but applies to all the individual order documents. This functionality of supplementing the individual message data with header data or metadata can be seen in the common example of SOAP envelopes (see Recipe 1-11 for more information about SOAP envelopes). Within BizTalk Server, envelope processing for received messages occurs in the Disassemble stage of a receive pipeline. The out-of-the-box XML receive pipeline handles the removing and parsing of any envelope data contained within the inbound document. The subschemas are dynamically determined at runtime by the envelope’s properties (specifically, the Body XPath), and used to validate the child documents’ structure and split each out into an individual message. A custom receive pipeline can also be used to more precisely process inbound enveloped documents. By leveraging the XML disassembler pipeline component, the envelope and document (child document) schemas can be set explicitly in the properties of the component. All envelope and document schemas explicitly set should have unique target namespaces. (See Recipe 3-8 for more information on custom pipeline components.)
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■Note If envelope or document schemas are explicitly set on an XML disassembler component, only documents matching those schemas will be processed within the pipeline. The order of envelope schemas is enforced based on the configuration within the Envelope property on the XML disassembler component. In contrast, the order of the document schemas is not enforced.



After the inbound enveloped document has been debatched into individual messages, the disassembler promotes any properties of the envelope to each individual message. In the example, if the BatchID had been configured as a promoted property, it would have been attached to each individual message during disassembly. Implementing envelopes for outbound messages is also possible within BizTalk Server. This process is handled in the assembling stage of a send pipeline. By leveraging the XML assembler pipeline component in a custom send pipeline, the envelope schemas can explicitly be set in the properties of the component. As it passes through the custom pipeline, the message will be wrapped in the specified envelope(s), and have the appropriate message properties demoted to the envelope. If a batch of outbound messages is sent through the custom send pipeline, the batch of messages will all be combined into a single document and wrapped in the specified envelope. In addition to having a single envelope, a group of messages can be wrapped in a series of nested envelopes. Using nested envelopes provides a flexible way for transferring message batches that have a complex structure or relationship. While the preceding solution used BizTalk Server’s pipeline capabilities to handle inbound envelope processing, there are other implementation options to consider when designing a solution. A loop can be used within an orchestration to iterate over child records within an enveloped document, splitting out each submessage individually using XPath queries or a node list object. An orchestration can also be used to call out to an external assembly to handle message debatching. When determining which method to use, it is important to consider the following: • Does the entire batch need to be handled transactionally (for example, if one of the messages fails to process correctly, should the entire batch be canceled)? • Do the individual records within the batch need to be processed in a specific order (for example, in the same order in which they appear in the original document)? • Does there need to be any event or notification after all messages in the batch are successfully processed? • Is business logic (orchestration) implemented on each individual message after it has been debatched? If your business scenario would lead you to answer yes to any of these questions, using an orchestration to handle the parsing of an enveloped document may be required. The main benefit of using an orchestration is enhanced control over the processing of the individual messages. The order of the messages can be maintained, scopes can be used to implement transactionality across the entire message batch, compensating and error handling are more robust, and it is simple to implement logic required when all messages within a batch have completed processing. The major downsides to using orchestrations for debatching are
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performance and ease of modification to the solution (as changing the orchestration requires you to redeploy the BizTalk Server solution). If the requirements of your business scenario allow for envelope processing to be handled via pipelines, you will realize performance gains. Additionally, the solution will be simplified by minimizing the number of implemented artifacts.



1-8. Creating Complex Types Problem You would like to create your own data type, by implementing your own complex type.



Solution You can use XSD complex types within the BizTalk Editor. As an example, assume that you need to create your own complex data type for storing shipping addresses for an Order schema: For this example, the Order schema has been built with Order Header nodes and the record. The following steps outline how to create a complex type to be the data type for the and addresses. You will model the data type of the existing record. 1. Open the project that contains the schema. 2. Double-click the schema (the Order schema in this example) to open it, as shown in Figure 1-19.
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Figure 1-19. Order schema



3. Click the existing record on which you want to base the complex type (the record in the Order schema in this example). 4. In the Properties window, within the General group, click Data Structure Type and type Address in the box. This step will now automatically recognize the record as a complex data type. Now you can reuse the complex type. For example, here are the steps to create a record that uses the sample complex type: 1. Click the Order schema node. 2. Right-click and select Insert Child Record. Type in the record name ShipFrom. 3. Click the newly created child record. 4. In the Properties window, within the General group, click Data Structure Type and select your complex type, Address. This procedure creates the Address complex type element structure under the ShipFrom record. A sequence instruction is created under both the ShipFrom and ShipTo records to implement the complex type. Figure 1-20 shows the finished schema.
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Figure 1-20. Order schema with the Address complex type



How It Works The example demonstrated creating a complex type data type based on an existing schema record within the schema. By XSD definition, a complex type is an element (record) that has child elements or attributes. Complex types can be used to implement custom schema rules and XSD data structure considerations for records, elements, and attributes. For example, you might use complex data types for validation rules via XSD regular expressions, schema cardinality, and order. In addition, you can make data type references to your complex types, allowing you to reuse record structures and XSD implementations. A complex type is derived from the base data type anyType; that is, in the purest form, a complex type is in essence a stand-alone base type, in which you can define your own XSD structure representation and schema rules.



■Note A simple type is an element that in itself is defined and does not have children. For example, you might have a simple type named Order ID, which has a length limit of 6 and must start with an A character. In this instance, an XSD length restriction could be defined, along with a regular expression to check that the order starts with the letter A: Axxxxx .
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1-9. Defining Regular Expressions Problem You have field elements or attributes in your schema for which you want to restrict the valid content beyond data type, enumerations, length, and minimum and maximum values.



Solution You can use the Pattern property of a field element or attribute to place a collection of regular expressions. Regular expressions are used to do pattern matching against the inbound data for the node. If the inbound data adheres to the pattern(s) defined for a node, then the input instance document will pass XML validation. If the inbound data for the node does not match the pattern(s), then the input instance document will fail XML validation. From within the BizTalk Editor, follow these steps to add a regular expression to a field element or an attribute: 1. Select the field element or attribute node to which you wish to add restriction patterns. 2. Right-click and select Properties. 3. Set the Derived By property to Restriction. This will enable the Restriction properties within the Properties window. 4. Select the ellipsis next to the Pattern property to launch the Pattern Editor dialog box, as shown in Figure 1-21.



Figure 1-21. Pattern Editor dialog box 5. Add one to many valid regular expressions, and then click OK. The BizTalk Editor will add these restriction patterns to the schema definition.



■Note Although XSD regular expressions are similar to those in other programming languages that allow for pattern matching, there are some differences. Refer to the W3C specification for the specifics of the regular expression syntax for XSD.
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How It Works More-restrictive validation of the input data may be of value for numerous types of data, such as phone numbers, IP addresses, and Social Security numbers. In these cases, you can use regular expressions to restrict the type of data that will be considered valid. Once you have created a schema that has nodes with pattern value restrictions, you can use the Generate Instance and Validate Instance capabilities of the BizTalk Editor to test your patterns. See Recipe 1-1 for more information about these two features.



■Note If you have pattern restrictions for a node(s) in your schema, the Generate Instance option will not create an instance document with valid data for those nodes. You will need to edit the instance document created. However, the Validate Instance option will validate the schema, including restriction patterns.



At runtime, neither the PassThruReceive nor the XMLReceive pipeline will complete a strict validation of the inbound document against the schema including the pattern matching. To complete a thorough validation of an inbound document, you must create a validation pipeline and add the document schema to the Document Schema property of the XML validator (see Recipe 3-5 for more information about creating validation pipelines). If the document fails schema validation in the pipeline, the instance will terminate and you will see a failure message in Health and Activity Tracking (HAT) that indicates the error that occurred. Figure 1-22 shows an error in HAT when a phone number does not match the restriction pattern defined in the schema.



Figure 1-22. Viewing a message in HAT
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In practice, it may be more beneficial to handle the strict validation of data more gracefully than terminating the instance when the validation fails. This is especially true if the document is coming from an outside source or from a system that is outside your control. However, restriction patterns can be used to safeguard downstream systems and processes from bad data.



1-10. Creating Flat File Schemas Problem You are consuming an inbound message in a flat file structure and must represent the data in an XML schema. The inbound flat file contains records that are both positional and delimited.



■Note Delimited files contain characters (such as commas) that separate the data. Files that are positional in nature contain data items that are a predefined length within the file. The physical position of the data defines what the data represents.



Solution The solution outlined in this recipe consumes an inbound flat file schema message that may have a structure similar to the flat file shown in Listing 1-1. Additionally, this recipe outlines the steps required to manually create a schema for a flat file. BizTalk 2006 also includes a Flat File Wizard for creating flat file schemas (see Recipe 10-1)



■Note The number bar at the top of Listing 1-1 is included for reference only and is not part of the file content. The number bar is for counting the position of the characters.



Listing 1-1. CustomerSalesOrder.txt 123456789012345678901234567890123456789012345678912345678901234567890 ORDER2004-10-24 SoldTo Shauna Marie 1223 Buttercup Lane Seattle WA 98155 ShipTo Jen Schwinn 3030 Moby Road Kent WA 98110 ITEMS,ITEM111-AA|Merlot|1|2.00|Bottle of Wine,ITEM111-AB|Cabernet| 1|2.00|Bottle of Wine Additionally, the outbound BizTalk schema may have a structure similar to the XML file shown in Listing 1-2.
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Listing 1-2. CustomerSalesOrder.xml 10/24/2004 SoldTo Shauna Marie 1223 Buttercup Lane Seattle WA 98155 ShipTo Jen Schwinn 3030 Moby Road Kent WA 98110 ITEM111-AA Merlot 1 2.00 Bottle of Wine ITEM111-AB Cabernet 1 2.00 Bottle of Wine Follow these steps to create the flat file schema: 1. Create a new BizTalk schema and select the Flat File Schema template. 2. Determine the structure and layout of your message schema. The structure and layout of the message schema will largely determine how the inbound document is parsed. In the XML sample in Listing 1-2, all data fields were defined as string elements. The customerHeader, items, and item nodes are defined as records.
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3. Select the root node (the orders node in this example) and specify the child delimiter to be a carriage return and a line feed (CRLF). The most straightforward way to set the delimiter to a CRLF is by setting the child delimiter type to be Hexadecimal. 4. Specify the child delimiter to be 0x0D 0x0A. 5. Set the child order to be Infix. 6. Set the tag identifier to read ORDER. The tag identifier tells the schema where the data begins for the message. The children data for the root node of order are delimited by commas that appear in the middle of the data. 7. Based on the fact that there are two instances of customerHeader information, the max cardinality for customerHeader record must be set to 2. 8. Set the structure for the customerHeader to positional since all of the child elements that represent customer information are related in a positional format within the flat file. Each child node that exists under customerHeader must have the position defined for the length of the data and the offset for where that value begins in the file. The way the value is represented starts from the left of the data element. For the length and offset of each element, see Table 1-3. 9. Set the next node tag value to ITEMS since Items is the next heading in the flat file. 10. Identify the delimiter as a comma and set the child-order to prefix, since each item will be prefixed with a comma to indicate the beginning of that item. 11. Make sure that the child delimiter type is set to character. Select item and make sure the child delimiter is set to the pipe character (|), since the attributes for the items are delimited by the pipe character in the flat file. 12. Set the pipe character to infix, since each line has pipe characters set in between the delimited characteristics. Figure 1-23 shows the CustomerSalesOrder schema in BizTalk. Table 1-3. Customer Header Child Elements



Element



Positional Length



Offset



customerType



7



0



fullName



16



0



street



20



0



city



14



0



state



3



0



postal



5



0
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Figure 1-23. CustomerSalesOrder schema layout To test the flat file output of the schema, follow these steps: 1. Verify that Generate Instance Output Type on your schema reads Native. The Native property allows the schema to generate the native file format, which is a flat file, for that schema. 2. Right-click the schema and select Generate Instance. You should see the default generated flat file, as shown in Figure 1-24.



Figure 1-24. Flat file generated schema
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To test the flat file schema to see the XML generated based on the provided flat file, follow these steps: 1. Verify that Generate Instance Output Type on your schema reads XML. The XML property allows the schema to process the inbound flat file and translate that flat file to an XML representation. 2. Right-click the schema and select Validate Instance. You should see the XML version of the processed flat file, as shown in Figure 1-25.



Figure 1-25. Validating the flat file schema



How It Works BizTalk is capable of processing both positional and delimited data, either in individual files or in a single file. The child delimiter is the key concept to keep in mind when creating a flat file schema. Any parent-level record that contains child elements or attributes must define whether the data in the flat file for those child records is delimited or positional and how the data is delimited. Based on the layout of the destination message schema, you should consider the following when dealing with records versus dealing with child elements and attributes: Records: If you use records to group child elements or attributes, consider how the child records will be demarcated. Will the child data be delimited or is the child data positional? In the example in Listing 1-1, each line of data is delimited by a CRLF. Knowing that each line of data is delimited by a CRLF aids in determining whether the output schema must support that specific delimiter. The basic line delimiter information points to the need of specifying a delimiter of a CRLF for the parent record of the output schema. Tag identifiers: Records may contain tag identifiers to distinguish one type of record from another record. A tag value also allows you to identify where data begins in the file.
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Positional elements/attributes: In the XML example in Listing 1-2, the customerHeader data is stored in positional format. For each child node, you must provide the offset (where to start reading the data) and the length for that data item. Additionally, the parent record must specify that the child data structure is Positional. Delimited elements/attributes: The flat file example in Listing 1-1 shows multiple items occurring on the same line delimited by the pipe (|) character. The attributes related to a single item are then further delimited by the comma character. The item’s parent record must specify that the child data structure is Delimited. Additionally, the child delimiter for the item’s parent record must specify that each item is delimited by a pipe character. Cardinality for records: By default, BizTalk sets the cardinality field for records and elements/attributes to a default value of 1. The value of 1 means that you expect to receive a maximum and minimum of one instance of that record and associated child values. If you expect an inbound flat file to contain more than a single record instance, you must change the max occurs value to a number equal to unbounded or the number of instances you expect to receive. Wrap characters: If the incoming data contains characters that have been identified as delimiting characters (for example, commas), those characters can be ignored through the use of wrap characters. For example, if the record contained the name Shauna, Marie and you wanted to have the comma included as part of the name, you could define a wrap character of " (double quote) and enclose the name within the wrap character: "Shauna, Marie". BizTalk will treat any special characters defined within a set of wrap characters as field-level data. Escape characters: The purpose of escape characters is very similar to that of wrap characters. Escape characters specify the character to be used to escape reserved characters, and then the reserved characters will be treated as literal characters in a message. If the records are delimited, you must determine how the records are delimited. For managing CRLF type transactions, the child delimiter type is set to hexadecimal and the delimiter is set to 0x0D 0x0A. If the delimiter is a character value like a comma, set the child delimiter type to character. The other key consideration for using delimiters is defining the child-order of the delimiter: • If the delimiter appears after the set of data, the child-order of the delimiter is postfix. • If the delimiter appears before the set of data, the delimiter is prefix. • If the delimiter appears in the middle of the set of data, the delimiter is as infix. The default child-order for a record is conditional default. The conditional default value means that if a tag value has been set for that record, then the child-order will be prefix. Otherwise, the child-order will be infix. If the records are positional, you must determine the spacing of the delimited data. In the example, it was assumed that there were no spaces between the data (offsets set to 0) and the beginning of the data fields started at the left of each data value.
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Another key consideration to keep in mind is the cardinality of the data groupings. When a BizTalk schema is created, by default, the cardinality is set to 1 (even if no cardinality value is explicitly set for a field). In the example, keeping the cardinality of the items set to the default would have caused some data to be lost when parsing both the customerHeader values and the item values. In the example, the cardinality of the max value was changed to 2 to account for both the shipTo and soldTo values.



1-11. Creating SOAP Header Schemas Problem You are using the publish/subscribe method in your orchestration architecture with many different schemas, and there are a number of common fields that need to be passed with all documents delivered to the BizTalk MessageBox (using direct binding on all ports). You want to be able to pass these fields without adding them to all of the individual schemas.



Solution Assume that you have three schemas as follows: ID_0 true Name_1 ID_0 true CompanyName_2 ID_0 true AddressLine_1 Two of the elements are common in all three of the schemas and represent values that are common: ID represents a common tracking ID, and TraceFlag represents whether logging should occur in an orchestration. The elements are not truly part of the description of a Person, Company, or Address, but their values need to be available. Your goal is to move these common fields out of the schemas so that they look as follows: Name_1 
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CompanyName_2 AddressLine_1 All messages in BizTalk are passed through the MessageBox wrapped in a SOAP Envelope. A SOAP Envelope consists of two sections: the Header and the Body, wrapped in an Envelope, as shown in Listing 1-3. The Header can be common across all schemas, while the Body contains the actual XML instance of any given schema. Adding and accessing fields within orchestrations at the SOAP Header level is made available in a simple and straightforward way. This is a powerful and useful tool that has multiple applications depending on the solution architecture. Listing 1-3. Sample SOAP Envelope Structure $1000), keep in mind maintenance and where in your organization a decision may be made to change this rule. In addition, always consider the right place to maintain rules and context domain knowledge from an operation and support perspective. Performance considerations: While mapping is powerful, complex and/or large maps can affect performance. As with all common development activities, always ensure that the logic performed is the most efficient and tested for scale in your practical operating conditions and requirements. If you experience performance issues, employ techniques such as revisiting design by exploring the solution breakdown. Consider simplifying the development task at hand. Like all good development processes, maps should be designed and tested for desired application operation conditions. The example in this recipe showed a baseline solution of what can be performed with the BizTalk Mapper. Throughout this chapter, other mapping capabilities will be demonstrated, illustrating the use of functoids and mapping techniques for structure and transformation control.



2-2. Organizing Maps Problem Maps can become very complex and hence difficult to read and maintain.



Solution BizTalk Sever provides two main features to aid in the readability and maintainability of maps. One of these features is grid pages. BizTalk Server allows you to create, name/rename, and order grid pages. When you create links between source and destination elements, the links will appear on only the selected grid page. Therefore, you can segment groups of links onto different grid pages. By default, a map file is created with one grid page named Page 1. Once you have selected source and destination schemas, you can access the grid page menu by right-clicking the tab at the bottom of the grid page, as shown in Figure 2-6.



Figure 2-6. Click the tab at the bottom of the grid page to access the grid page menu.
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From this menu, you can perform the following functions: • Select Add Page to add a new grid page to the map. • Select Delete Page to delete the selected grid page. (If you delete a grid page, all of the links associated with that grid page will also be removed.) • Select Rename Page to rename the selected grid page. • Select Reorder Pages to launch the Reorder Pages dialog box, as shown in Figure 2-7. From this dialog box, you can change the order in which the grid pages appear when viewing the map file.



Figure 2-7. Reorder Pages dialog box Another feature provided by BizTalk Server for facilitating the readability and maintainability of maps is the ability to label links. While the labels do not appear on the grid pages, they will be used to designate the input parameters for functoids. By default, a functoid will show the XPath designation if it is linked directly to a source field, or it will show the name of the previous functoid if it is linked from another functoid. However, if the input links to a functoid are labeled, then the Label property of the link will be shown. To label a link, follow these steps: 1. Open the project that contains the map. 2. Open the map file. 3. Select the grid page that contains the link to be labeled. 4. Select the link to be labeled, right-click, and select Properties. 5. Fill in the Label property.
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How It Works There are many ways to segment a map into multiple grid pages. For example, you can create a grid page for each major node in a source schema that requires complex mapping. Regardless of how you divide the map, the goal of using multiple grid pages should be to improve the readability and maintainability of the map. Figure 2-8 shows a simple map to highlight the use of grid pages and labeling links. Two grid pages were used. The first grid page, Name, holds the links and functoids to map a FirstName and LastName field to a FullName field that is all uppercase. The second grid page, Birthday, holds the link for DateOfBirth to Birthday. To emphasize the use of link labeling, the FirstName field was passed through the Uppercase functoid and the String Concatenate functoid without the use of link labeling. The LastName field was passed through the Uppercase functoid and String Concatenate functoid with the use of link labeling.



Figure 2-8. A simple map with grid pages and labeling
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Figure 2-9 shows the input parameter for the Uppercase functoid linked to the FirstName field in Figure 2-8. Notice that the input parameter is designated by the XPath query to the FirstName field.



Figure 2-9. Uppercase functoid input without a link label Figure 2-10 shows the Uppercase functoid linked to the LastName field in Figure 2-8. However, the link from the LastName field to the functoid was labeled with LastName. Notice how the input parameter is labeled as LastName, as opposed to an XPath query to the LastName field.



Figure 2-10. Uppercase functoid input with a link label
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Figure 2-11 shows the input parameters for the String Concatenate functoid. This functoid takes in the FirstName, a constant to add a blank space, and then the LastName, and concatenates all three together into a FullName field on the destination schema.



Figure 2-11. String Concatenate functoid input parameters Notice how the first input parameter is shown as Uppercase, as opposed to anything meaningful. This is simply the name of the functoid previous to the String Concatenate functoid. However, the link between the Uppercase and String Concatenate functoids for LastName was labeled as LastNameAllCaps. Notice how that label appears as the third input parameter.



2-3. Adding Mapping Constants Problem You would like to use constant values within a BizTalk map. This might be because of preset output map values within a destination schema (that do not exist in the source schema), to assist in general programming concepts when using functoids, or for other reasons.



Solution To demonstrate how to add map constants using the BizTalk Mapper, suppose that you want to use a constant in conjunction with a String Extraction functoid. In this example, you would like to extract a specified number of characters (five) from the left of the source element value. In the source schema, Customer, you have Zip elements like this: 98103-00001 In the destination schema, CustomerRecord, you have Zip elements like this: 98103
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To map constants, follow these steps: 1. Set up the BizTalk map with the appropriate source and destination schema (see Recipe 2-1), as shown in Figure 2-12.



Figure 2-12. The source and destination schema for the constant mapping example 2. In the left pane, click the Toolbox, and then click the String Functoids tab. 3. Click and drag a String Left functoid onto the map surface. 4. Double-click the Zip element in the source schema and drag it across to the left point of the String Left functoid. 5. Click the String Left functoid on your map surface and select Input Parameters in the Properties window. The Configure Functoid Inputs dialog box is now displayed, as shown in Figure 2-13. Notice the first input parameter is the source schema’s Zip element. This is automatically configured as a result of dragging the source Zip element onto the map surface.



Figure 2-13. Configure Functoid Inputs dialog box
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6. In the Configure Functoid Inputs dialog box, click the Constant icon. 7. Select the newly created constant, and type in the value 4. As noted, you are extracting five characters for the zip code. Because the functoid is zero-based, the start position will be 0 and the end position will be 4, resulting in five characters. 8. Click OK to complete the functoid configuration. 9. Click on the right side of the String Left functoid and drag it across to the Zip element in the destination schema. This completes the functoid configuration. The finished map is shown in Figure 2-14.



Figure 2-14. Customer map created with a map constant



How It Works You might use constant mapping for the following: • To support functoid configuration, as in the example in this recipe, which used the String Left functoid. • For values declared and assigned within a Scripting functoid. In essence, these values can be mapped as output into destination values. Furthermore, they can be declared once, and accessed as global variables within other Scripting functoids in the context of the working BizTalk map. • With the String Concatenate functoid. Use the input parameter of this functoid as the constant value required. This functoid does not require any input values from the source schema. In this usage, a String Concatenate functoid would simply be mapped through to the desired destination value. The best use of constant mapping depends on the situation and requirements you are developing against. Examine the likelihood of change within the scenario where you are looking to apply the functoid constant. If there is a high likelihood that values and their application will change, consistency should be the major factor to facilitate maintenance.
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If constants are set via deterministic logic or complex or embedded business rules, it might be worth thinking about whether the constant should be applied in the map or applied within a scripting component or upstream/downstream BizTalk artifacts. The key is understanding where rules and deterministic values are set to support the specific situation. Apply the appropriate design principles to ensure the correct constant assignment technique is applied. You might decide it would be best to map values outside the mapping environment. This could be a result of deterministic logic or business rules being the major requirement in the constants implementation. Furthermore, rules that derive constants may exist outside the BizTalk map. Constants may need to change dynamically, and it may be too cumbersome to perform a recompile/deployment for such changes within a BizTalk map.



2-4. Mapping Any Element Nodes Problem You need to create a mapping between two schemas containing elements and attributes that are unknown when building the map, and you must include the unknown schema structures in your mapping.



Solution You can include unknown schema structures in a map by using the element. 1. Build a source message schema containing an element, as shown in Figure 2-15.



Figure 2-15. Creating a source message
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2. Build a destination schema containing an element, as shown in Figure 2-16.



Figure 2-16. Creating a destination message 3. Right-click the BizTalk project in the Solution Explorer and select Add ➤ Add New Item to open the Add New Item dialog box. 4. Select the Map template in the right pane, specify the desired name of the BizTalk map that you want to create, as shown in Figure 2-17, and then click Open.
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Figure 2-17. Adding a new map to the BizTalk project 5. In the empty map created in the development environment, select the Open Source Schema link on the left side. In the BizTalk Type Picker dialog box, select the source schema (Customer in this example), and then click OK. 6. Select the Open Destination Schema link on the right side of the map. In the BizTalk Type Picker dialog box, select the destination schema (InvoiceRecipient in this example), as shown in Figure 2-18, and then click OK.



Figure 2-18. Specifying the destination schema
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7. Click the Toolbox, and then click the Advanced Functoids tab. Drag a Mass Copy functoid onto the map surface. Connect the Address element from the source message to the Mass Copy functoid, and connect the Mass Copy functoid to the Address field of the destination message. (See Recipe 2-6 for details on how to use the Mass Copy functoid.) 8. Create other desired mapping links normally, as shown in Figure 2-19.



Figure 2-19. Configuring the Mass Copy functoid



How It Works An element in a schema designates a specific location in the schema where new elements or attributes can be added. When BizTalk uses the schema to process a message containing unknown elements or attributes in the designated location, the schema will still consider the message valid. If this source message is mapped into a different schema that also has a location designated for extensibility with an element, then the information must be copied to that location with the Mass Copy functoid.
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■Note By default, BizTalk will examine only the namespace and root node name of a message to identify the schema, and will not detect extra elements in the message body. To perform a deep validation of a message format, create a receive pipeline with the XML disassembler, specify the schema to validate messages against, and set Validate Document Structure to true. See Chapter 3 for more information about how to configure receive pipelines.



The contents of an element cannot be mapped with most of the default BizTalk functoids. Other functoids require establishing an explicit link from a source field, and that is not possible if the source field is not known at design time. The Mass Copy functoid can be linked only directly to an ancestor of the element, which may not give the granularity of control desired. Consider using an XSLT script with the Scripting functoid (see Recipe 2-21) to achieve finer control. For example, if you know some element will be present at runtime but cannot predict the element name of its parent, an XSLT script can still perform the mapping. Sometimes, the BizTalk development environment has difficulty validating schemas containing elements. It can incorrectly determine that elements and attributes appearing in the location designated by the schema should not be there, causing validation for the schema to fail. This complicates schema development because the developer must deploy the schema with a pipeline capable of validating the document structure to check if the schema is correct according to a sample source message. To avoid this deployment effort while developing the schema, wait to add elements until the rest of the schema is developed and verify that those other elements are defined correctly. Then when adding the elements to the schema, there will be a baseline of what is working correctly.



2-5. Using the Value Mapping Functoid Problem You need to understand how and when to use the Value Mapping functoid and the Value Mapping (Flattening) functoid.



Solution BizTalk provides two Value Mapping functoids: Value Mapping and Value Mapping (Flattening). Both will cause a new record to be created in the destination for every record in the source. The Value Mapping (Flattening) functoid is used when the destination document has a flat structure. Both functoids require two input parameters: a Boolean value and the node that is to be mapped. If the Boolean value is true, the value will be mapped; otherwise, it will not be mapped. The following steps demonstrate the use of the Value Mapping functoid in a map, using the source document shown in Listing 2-1.
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Listing 2-1. Source Document for the Value Mapping Functoid Example 1999-04-05T18:00:00 1 C. LaBarge Consultant 73 2 D. Riggs Finance 88 3 T. Trucks Consultant 94 These steps refer to the Value Mapping functoid, but are identical for the Value Mapping (Flattening) functoid. 1. Click the Toolbox, and then click the Advanced Functoids tab. Drop the Value Mapping functoid on the map surface between the source and destination schemas. 2. The first parameter for the Value Mapping functoid needs to be a Boolean value. For this example, a Not Equal functoid will be used to generate the Boolean value. In the Toolbox, click the Logical Functoids tab, and drop a Not Equal functoid to the left of the Value Mapping functoid. The first input parameter for the Not Equal functoid should be the value from the Role element. The second input parameter should be a constant value. Set this value to Finance. This will ensure that only those records that are not in the Finance role will be mapped across. 3. The second parameter for the Value Mapping functoid in this example is the Name element from the source document. Ensure that a line exists between this node and the functoid. 4. Drop the output line from the Value Mapping functoid on the Company/Employees/ Person/Name node in the destination document, as shown in Figure 2-20.
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Figure 2-20. Using the Value Mapping functoid At this point, the map can be tested. Using the source document shown in Listing 2-1, output of the map is the document shown in Listing 2-2.



■Note If the Value Mapping (Flattening) functoid does not map a value across, the node is not created on the destination schema, whereas if the Value Mapping functoid does not map a value, an empty destination node will be created. To change this behavior, you will need to use additional functoids or scripting.



Listing 2-2. Output Document Using the Value Mapping Functoid C. LaBarge T. Trucks 
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If the Value Mapping functoid is replaced with the Value Mapping (Flattening) functoid (as shown in Figure 2-21), the document in Listing 2-3 will be output.



Figure 2-21. Map with Value Mapping (Flattening) functoid



Listing 2-3. Output Document Using the Value Mapping (Flattening) Functoid C. LaBarge T. Trucks 



How It Works This example showed the default behavior of the Value Mapping functoid. However, the default output of the Value Mapping functoids can be altered through the use of additional functoids and scripting. For example, notice that the output in Listing 2-3 is flat instead of nested (two Person nodes within the Employee node). By adding a Looping functoid (see Recipe 2-13) to the Name element (or any required element in the Person node) in the source document and attaching it to the Person root node in the destination document (see Figure 2-22), you can obtain nested output, as in Listing 2-4. The output is identical to using the Value Mapping functoid as shown in Listing 2-2.
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Figure 2-22. Using the Value Mapping (Flattening) and Looping functoids



Listing 2-4. Output Using Value (Mapping) Flattening and Looping Functoids C. LaBarge T. Trucks One of the most common situations in XML document mapping is working with nonexistent elements. By default, if an element does not exist in an incoming document but is mapped to the destination document in a BizTalk map, the node on the destination document will be created with a null value (). The use of a Value Mapping (Flattening) functoid causes the node to be created in the destination document only if the source node exists in the source document.



2-6. Using the Mass Copy Functoid Problem You would like to copy child XML structures from a source to destination schema.
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Solution Using the Mass Copy functoid, a source XML structure can be recursively mapped to a compatible XML structure on the destination schema. For example, suppose you have the following two schemas: To copy and map the People schema to the Person schema, follow these steps: 1. Set up the BizTalk map with the appropriate source and destination schema, as shown in Figure 2-23.



Figure 2-23. The source and destination schema for the Mass Copy functoid example 2. In the left pane, click the Toolbox, and then click the Advanced Functoids tab. 3. Click and drag a Mass Copy functoid onto the map surface. 4. Click the Person element in the source schema and drag it across to the left point of the Mass Copy functoid.
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5. Click the right point of the Mass Copy functoid and drag it across to the People element in the destination schema. The map is now complete, as shown in Figure 2-24.



Figure 2-24. Using the Mass Copy functoid



How It Works The Mass Copy functoid allows source records and containing elements and attributes to be copied and mapped across to the destination schema. This in turn, allows large structures to be mapped quickly in design time, without the need of performing 1:1 detailed mapping on all subsequent schema nodes. The Mass Copy functoid performs the recursive copying by applying a wildcard (/*) XSLT template match on source to destination XML elements. This is of particular benefit when the destination is defined as an type. Consider the scenario where you do not have a preset data structure within your destination schema; for example, communicating an error message with reason code, description, category, and so on, where order and cardinality are not important. By applying the Mass Copy functoid, you could map through the parent element and allow the destination XML object to be determined and derived at runtime. When mapping from source to destination, only the structure under the destination parent XML record will be copied. This often results in having to re-create the parent record element to allow all subsequent children nodes to be mapped to the destination schema. For example, consider the following two schemas, Customer and Customers: 
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In this instance, the record cannot be mapped to the record on the destination schema. A containing element will need to be defined on the destination schema to enable the correct operation of the Mass Copy functoid mapping. When mapping source to destination elements, always be cautious of underlying XSD schema rules, such as cardinality, order, and data types. For example, the Mass Copy functoid will “blindly” copy all child elements specified to the destination schema. It will not copy elements out of order or check for required values in the destination schema. Changes to the source and destination schema may result in the need to update your impacted maps leveraging the Mass Copy functoid. This, in turn, will mandate a recompile and deployment of your BizTalk solution. Using the Mass Copy functoid within the BizTalk Mapper is one of a variety of ways to recursively copy elements. The following are three key approaches to recursively copy XML structures: Mass Copy functoid: Creates a wildcard XSLT template match to recursively copy elements. This approach may provide a performance benefit, as each source and destination element does not require a 1:1: XSLT template match. This, in turn, requires fewer XSLT code instructions to be interpreted and executed at runtime. Recursive mapping: This is achieved by holding down the Shift key and mapping from a source to destination record element. This is a usability design feature that enables a developer to perform recursive mapping via one keystroke. This approach implements 1:1 XSLT template matches on all source and destination elements. Straight-through mapping: This approach is to manually link all source and associated destination elements within the BizTalk Mapper tool (see Recipe 2-1). This method does 1:1 template matches on all source and destination elements.



2-7. Using the Table Looping Functoid Problem You need to create a repeating structure in an output document with no equivalent repeating structure in an input document.



Solution BizTalk Sever provides two functoids, the Table Looping functoid and the Table Extractor functoid, for creating a repeating node structure from a flattened input structure, from constant values, and from the output of other functoids. The Table Looping functoid is used to create a
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table of information based on inputs. The functoid will generate output for each row from this table. The Table Extractor functoid is used to direct data from each column in the table to a node in the destination document. Following are the basic steps for configuring these functoids. 1. Click the Toolbox, and then click on the Advanced Functoids tab. Drag the functoid onto the map surface, and create links to the functoid. a. Set the first input parameter, which is a link from a node structure in the input document that defines the scope of the table. If this node repeats in the input document, the number of occurrences of this element in the input document will be used to control the number of times the set of Table Extractor functoids will be invoked at runtime. b. Set the second input parameter, which is a constant that defines the number of columns for each row in the table. c. Set the next input parameters, which define the inputs that will be placed in the table. These inputs can come from the input document, the output from other functoids, constant values, and so on. 2. Configure the table based on inputs for the Table Looping functoid. a. Select the ellipsis next to the Table Looping Grid property in the Properties window to launch the Table Looping Configuration dialog box. b. For each cell, select a value from the drop-down list. The drop-down list will contain a reference to all of the inputs you defined in step 1.c. c. Check or uncheck the Gated check box. If checked, column 1 will be used to determine whether a row in the table should be processed as follows: When the value in column 1 of the row is the output from a logical functoid, if the value is True, the row is processed, and if the value is False, the row is not processed. Similarly, if the value in column 1 of the row is from a field, the presence of data equates to True and the row is processed, and the absence of data equates to False and the row is not processed, and subsequently missing from the output structure. d. Select OK to close the dialog box. 3. Configure the outputs for the Table Looping functoid. a. Link the Table Looping functoid to the repeating node structure in the output document. b. Link the Table Looping functoid to a Table Extractor functoid for each column in the table. The Table Extractor functoid can be found in the Toolbox on the Advanced Functoids tab. 4. Configure the input parameters for each Table Extractor functoid. a. Set the first input parameter, which is the output link from the Table Looping functoid. b. Set the second input parameter, which is the column number of the data to be extracted from the table. 5. Configure the outputs for each Table Extractor functoid. Link the functoid to a node in the destination schema that is part of a repeating structure.
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■Note It is very helpful to label all of the links so that meaningful names are displayed when configuring these functoids. See Recipe 2-2 for more information about linking labels in maps.



How It Works The Table Looping and Table Extractor functoids are used together. As an example, suppose that you have the sample input document shown in Listing 2-5. Listing 2-5. Flattened Input Structure John Doe Sam Smith James Jones The goal is to use these two functoids to create an output document of the format shown in Listing 2-6. Listing 2-6. Repeating Nested Structure John Doe Sam Smith James Jones Figure 2-25 shows the configuration for the input parameters for the Table Looping functoid. The first parameter is a reference to the node structure Names in the input schema. The second parameter is a constant value of 2 indicating there will be two columns in the table. The remaining parameters are the first and last name of each alias from the input document.
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Figure 2-25. Table Looping input parameters Figure 2-26 shows the completed Table Looping Configuration dialog box for the Table Looping functoid. It has been configured so that each row contains an alias first name in column 1 and an alias last name in column 2. There will be three rows in the table to process, one for each alias provided as input. The output links from the Table Looping functoid are configured as follows: • An output link to the AliasNames repeating node structure in the destination schema • An output link to a Table Extractor functoid for processing first names (column 1) from the table • An output link to a Table Extractor functoid for processing last names (column 2) from the table Figure 2-27 shows the configuration for the Table Extractor functoid that will process column 1 from the table. The first parameter is a link from the Table Looping functoid, and the second parameter is a constant value of 1, which indicates it will process the first column from each row as it is processed.
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Figure 2-26. Table Looping Configuration dialog box



Figure 2-27. Table Extractor functoid configuration for column 1 Figure 2-28 shows the configuration for the Table Extractor functoid that will process column 2 from the table. The first parameter is a link from the Table Looping functoid, and the second parameter is a constant value of 2, which indicates it will process the second column from each row as it is processed.
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Figure 2-28. Table Extractor functoid configuration for column 2 Finally, each Table Extractor functoid must be linked to a node in the destination schema. The complete map is shown in Figure 2-29.



Figure 2-29. Final map for the Table Looping functoid example
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Here is what the data table will look like when the map is processed:



Column 1



Column 2



John



Doe



Sam



Smith



James



Jones



Once the table is loaded, it will generate three sets of output: one set of output for each row in the table. This, in turn, will create three repetitions of the AliasNames node structure in the destination document: one for each row in the table. A repeating node structure has been created, even though one did not exist in the input document.



2-8. Using the Database Lookup Functoid Problem You need to map an incoming node to a database table column to reference a specific set of data via a BizTalk 2006 Server map. Specifically, for an inbound author ID, you need to retrieve the person attributes that are stored in a SQL-based table. Additionally, the data that is stored in the database table is dynamic, and coding the values within the BizTalk map is not possible.



■Note The Database Lookup functoid can communicate with any ODBC-compliant data source. For this recipe, SQL Server is the assumed data source.



Solution BizTalk provides the Database Lookup functoid, which can retrieve a recordset. For example, suppose that the inbound message specifies an author’s Social Security number but no personal information. The map must retrieve the author’s information and map the information to the outbound message. The Database Lookup functoid can retrieve the information from a specific SQL table using the author’s Social Security number as the value for which to search. The inbound XML message may have a format similar to this: 172-32-1176 You can use the Database Lookup functoid by taking the following steps: 1. Click the Toolbox, and then click on the Database Functoids tab. On the map surface, in between the source and destination schemas, drag and drop a Database Lookup functoid. 2. Connect the left side of the Database Lookup functoid to the inbound document node that will specify the value used in the search.
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3. Configure the input parameters of the Database Lookup functoid, as shown in Figure 2-30. This functoid requires four parameters to be specified either through mapping the inbound source data to the functoid or through setting constants in the functoid. a. For the first input parameter, verify that the inbound node, connected in step 2, is the first value in the list of properties. This is a value to be used in the search criteria. It’s basically the same as the value used in a SQL WHERE clause. b. Set the second parameter, which is the connection string for the database. The connection string must be a full connection string with a provider, machine name, database, and either account/password or a flag indicating the use of Trusted Security mode in SQL. The connection string must include a data provider attribute. A lack of data provider attribute will generate a connection error when the map tries to connect to the database. c. Set the third parameter, which is the name of the table used in search. d. Set the fourth parameter, which is the name of the column in the table to be used in search.



Figure 2-30. Database Lookup Functoid input parameters dialog box 4. Again, click the Toolbox, and then click the Database Functoids tab. On the map surface, after the Database Lookup functoid, drag and drop the Error Return functoid.
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5. Connect the right side of the Database Lookup functoid to the left side of the Error Return functoid. Connect the right side of the Error Return functoid to the outbound schema node that is a placeholder for error messages. 6. Again, click the Toolbox, and then click the Database Functoids tab. On the map surface, above the Error Return functoid, drag and drop the Value Extractor functoid for each extracted value from the return recordset. For example, if you are returning five values in the recordset, you would need five Value Extractor functoids. 7. For each Value Extractor functoid, connect the left side of the functoid to the right side of the Database Lookup functoid. 8. Configure the properties of each Value Extractor functoid to retrieve the appropriate value by specifying the column name of the extracted value. For example, if the value returned resides in a column named au_fname, you would create a constant in the Value Extractor functoid named au_fname. The Value Extractor functoid’s Configure Functoid Inputs dialog box should look similar to Figure 2-31.



Figure 2-31. Value Extractor functoid input parameters dialog box 9. For each Value Extractor functoid, connect the right side of the functoid to the appropriate target schema outbound node. The completed map should look similar to the sample map in Figure 2-32.
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Figure 2-32. Using the Database Lookup functoid Based on the sample XML, the map in Figure 2-32 will produce the XML document shown in Listing 2-7 (assuming that the BizTalk map contains a connection string to the pubs database). Listing 2-7. Outbound Retrieve Author Information 172-32-1176 Johnson White 408 496-7223 10932 Bigge Rd. Menlo Park CA 94025 



How It Works The Database Lookup functoid requires four parameters as inputs, and it outputs an ActiveX Data Objects (ADO) recordset. Keep in mind that the recordset returns only the first row of data that matches the specific criteria provided to the Database Lookup functoid. In addition to the input parameters, the Database Lookup functoid requires two helper functoids for optimal use:
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• The Error Return functoid, which returns SQL-related errors or exceptions. The Error Return functoid requires the Database Lookup functoid as the input and a link to an output node in the target schema. To avoid runtime errors, verify that the only inbound connection to the Error Return functoid is that of the Database Lookup functoid and not any other database functoids. • The Value Extractor functoid, which retrieves a specific column from the returned recordset. The Value Extractor will retrieve the value based on the specific column specified in the input parameters.



Security Considerations Whenever you use SQL authentication (SQL username and password), there is potential for a security risk. Consider using Trusted Security for access to the database rather than specifying the username and password in the connection string used by the Database Lookup functoid. For example, here is a connection string that uses SQL security: Provider=SQLOLEDB;Server=localhost;Database=pubs;User ID=sa;Password=password; Trusted_Connection=False And here is an example of a connection string that uses Trusted Security: Provider=SQLOLEDB;Server=localhost;Database=pubs;Integrated Security=SSPI; Keep in mind that if you choose Trusted Security for authentication, the account under which the BizTalk host instance is running must have appropriate access to the SQL Server, the SQL database, and the table in which the Database Lookup functoid is looking. Another option to enclosing connection string information within the Database Lookup functoid is to make use of a Universal Data Link (UDL) file. A UDL is simply a text file with the file extension .udl. The connection string is included within the UDL file, and the connection string parameter in the Database Lookup functoid becomes a reference to that file, for example: File Name=c:\BizTalkConfig\ConnectionString.UDL Once the UDL file is created, it can be made available on a secure file share.



■Note UDL files are external to the BizTalk map and therefore must be parsed every time a connection to the database is open. The parsing activity will cause some performance degradation.



Additionally consider the use of a SQL view, versus direct table access, and having the Database Lookup functoid point to the database view. A SQL view offers the ability to manage table security permissions or the abstraction of the physical table structure.
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Architecture Considerations The Database Lookup functoid is convenient to implement in mappings. For straightforward data retrieval, this functoid performs adequately. However, the following items should be taken into consideration when evaluating when to use the Database Lookup functoid: Database availability: If you cannot guarantee that the data source being queried will be available when BizTalk is available, then using the Database Lookup functoid may not make sense. Error management: Mapping will occur and not trap the SQL errors in the .NET exception style. Errors should be trapped and managed when mapping. When implementing the Database Lookup functoid, consider using the Error Return functoid. Additionally, after the mapping, it would be wise to query the Error Return node for an error message and implement error handling if one exists. Performance: Evaluate your performance requirements and determine if accessing a SQL database will negatively affect your overall mapping performance. Implementing the Database Lookup functoid may not impact performance greatly, but consider the effect if you must run the Database Lookup functoid multiple times in a single map. Database Lookup functoids that are part of a looping structure will cause a level of performance degradation. Make sure that the latest BizTalk service packs are applied when using the Database Lookup functoid, as they include performance-enhancing features such as caching. Database support: Evaluate if the database that you must access will support the necessary security requirements and also allow table (or at least view level) access.



Advanced Database Lookup Functoid Usage The BizTalk map translates the Database Lookup functoid information into a dynamic SQL SELECT statement. If you run a SQL Profiler trace during testing of the BizTalk map, you will see the SELECT call with the dynamic SQL. Knowing that dynamic SQL is created by the Database Lookup functoid allows you to use it to perform some relatively powerful database lookups. The Database Lookup functoid allows only a single value and single column name to be referenced in the query. However, with a bit of extra mapping, you can use this functoid to query against multiple columns. The map in Figure 2-32 generates the following SQL query code: exec sp_executesql N'SELECT * FROM authors WHERE au_id= @P1', N'@P1 nvarchar(11)', N'172-32-1176' This query performs a SELECT to retrieve all rows from the authors table where the author ID is equal to the value in the inbound XML document (for example, 172-32-1176). Keep in mind that the Database Lookup functoid returns only the first row that it encounters in the recordset. If multiple authors had the same ID, you would potentially retrieve the incorrect author. For example, if the author ID is the last name of the author, you may retrieve multiple authors that share the same last name. One way to ensure uniqueness, aside from querying on a unique column, is to specify additional columns in the query. The Database Lookup functoid accepts only four parameters, so additional concatenation must occur before submitting the parameters to the Database Lookup functoid. Figure 2-33 shows a sample concatenation of parameters that submitted as a single parameter to the Database Lookup functoid.
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Figure 2-33. Concatenating Database Lookup functoid input parameters After configuring the inbound concatenated value, the next step is to specify multiple column names as the input parameter in the Database Lookup functoid. Figure 2-34 demonstrates a sample Database Lookup functoid configuration with multiple columns specified. The output from the Database Lookup functoid to the Value Extractor functoid does not change.



Figure 2-34. Database Lookup functoid with multiple columns
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■Note A plus symbol (+) is used between the column names in the Database Lookup functoid, whereas in the Concatenation functoid, no + is required. If a + is specified in the Concatenation functoid, you will receive incorrect results, as the dynamic SQL statement created will be incorrect.



In this example, the inbound message specifies an author’s first name and last name instead of a unique author ID. The map must still retrieve the author’s information and map the information to the outbound message. The inbound XML message may have a format to the following message: Ringer Albert Based on this source XML, the map specifying multiple columns will produce the following XML document (assuming that the BizTalk map contains a connection string to the pubs database). 998-72-3567 Albert Ringer 801 826-0752 67 Seventh Av. Salt Lake City UT 84152 The following is the dynamic SQL created in the map that accepts multiple columns: exec sp_executesql N'SELECT * FROM authors WHERE au_lname+au_fname= @P1', N'@P1 nvarchar(12)', N'RingerAlbert' The dynamic SQL created shows the inbound author’s first name and last name parameters as a concatenated parameter. The SQL statement also shows a combination WHERE clause with au_lname + au_fname. There are some limitations to specifying multiple columns through the concatenation approach. Specifically, string data types are the only data types that work reliably due to the concatenation operation that occurs in SQL. Integer data types may also be used, but in the case of integer (or other numeric data types), SQL will perform an additive operation versus a concatenation operation. Adding two numbers together, as what would happen when specifying numeric data types, and comparing the result to another set of numbers being added together may yield multiple matches and may not achieve the desired results. The mix of varchar and numeric fields will not work with this approach, as you will receive a data casting exception from your data provider.
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2-9. Seeding Cross-Reference Tables with ID Cross-References Problem You wish to dynamically cross-reference unique identifiers between two or more systems. The reference data already exists, so you wish to load the data into the BizTalk cross-reference tables before you use the cross-reference functoids or Application Programming Interface (API).



Solution Within an XML configuration file you name List_Of_App_Type.xml, insert the XML shown in Listing 2-8, and insert an appType node for each system that will have cross-references. Listing 2-8. List_Of_App_Type.xml Oracle Siebel 



■Note These node values in Listings 2-8 through 2-11 have been placed in the XML as an example. You should remove them and insert your own.



Within an XML configuration file you name List_Of_App_Instance.xml, insert the XML shown in Listing 2-9. Listing 2-9. List_Of_App_Instance.xml Oracle_01 Oracle Siebel_01 Siebel 
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Siebel_12 Siebel Since unique identifiers are often different for each unique instance of a system, you must create different cross-references for each system. Therefore, you must insert an appInstance node for each instance of an application you will cross-reference, inserting a common type value across instances that are of the same type of system, and which correspond to the appType you created in the List_Of_App_Type.xml configuration file. For instance, you may be running two instances of Siebel, so you would insert two appInstance nodes with a type of Siebel, but give each a unique value in the instance node (for example, Siebel_01 and Siebel_12). Within an XML configuration file you name List_Of_IdXRef.xml, insert the XML shown in Listing 2-10. Listing 2-10. List_Of_IdXRef.xml Customer.ID Order.PONumber For each ID field you plan to cross-reference, insert an idXRef node with a unique name child node. This value will be used to identify the ID field that you are cross-referencing. For instance, if you plan to cross-reference a customer that is in different systems, you would insert an idXRef with a name like Customer.ID. Within an XML configuration file you name List_Of_IdXRef_Data.xml, insert the XML shown in Listing 2-11. Listing 2-11. List_Of_IdXRef_Data.xml CARA345 
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99-4D976 44OL For each field you create in the List_Of_IdXRef.xml file, insert an idXRef node. For each system you create in the List_Of_App_Instance.xml file, insert an appInstance node. Insert one or more appID nodes for each unique identifier. Insert a commonID attribute to store a common identifier, and a set the application-specific value within the node. The common ID will be repeated for each appID that is cross-referenced. Within an XML configuration file you name Setup-Config.xml, insert the XML shown in Listing 2-12. Listing 2-12. Setup-Config.xml C:\List_Of_App_Type.xml C:\List_Of_App_Instance.xml C:\List_Of_IDXRef.xml C:\List_Of_IDXRef_Data.xml Each node should point to the physical location where you have created the corresponding XML configuration files. Seed the BizTalk cross-reference tables by opening a command-line window and running the BizTalk cross-reference import tool, BTSXRefImport.exe (found in the BizTalk installation directory), passing in the path to the cross-reference XML file created in Listing 2-12: BTSXRefImport.exe --file=C:\Setup-Config.xml



How It Works During installation of BizTalk, several cross-reference tables are created in the BizTalkMgmtDb database. All the cross-reference tables begin with the prefix xref_, and the BTSXRefImport tool imports the data from the XML files provided into the table structure for access at runtime. It is not necessary to use the BTSXRefImport.exe tool to insert data into the cross-reference tables. You may insert data directly into the following tables: • xref_AppInstance • xref_IdXRef • xref_IdXRefData
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After running the BTSXRefImport tool, and if the data were in a denormalized form, the data would look like this:



AppType



AppInstance



IdXRef



CommonID



Application ID



Oracle



Oracle_01



Customer.ID



100



CARA345



Siebel



Siebel_01



Customer.ID



100



99-4D976



Siebel



Siebel_12



Customer.ID



100



44OL



There are subtle differences between ID and value cross-referencing. Value cross-references, as the name implies, deal with static values, while ID cross-references deal with cross-referencing unique identifiers. Since most value cross-references are not updated at runtime, a functoid and API method are not provided to update the references at runtime. ID cross-references, though, may be updated using the Set Common ID functoid or API method. See Recipe 2-10 for more information about value cross-references.



■Note The Set Common ID functoid is poorly named, as it actually sets the application



ID and the



CommonID. If a CommonID is not provided, the method will return a new CommonID.



2-10. Seeding Cross-Reference Tables with Value Cross-References Problem You wish to statically cross-reference state values between two or more systems. The reference data already exists, but you must load the data into the BizTalk cross-reference tables before you may use the cross-reference functoids or API.



Solution Within an XML configuration file you name List_Of_App_Type.xml, insert the XML shown in Listing 2-13, and insert an appType node for each system that will have static cross-references. Listing 2-13. List_Of_App_Type.xml Oracle Siebel 
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■Note The node values in Listings 2-13 through 2-15 have been placed in the XML as an example. You should remove them and insert your own.



Within an XML configuration file you name List_Of_ValueXRef.xml, insert the XML shown in Listing 2-14. Listing 2-14. List_Of_ValueXRef.xml Order.Status For each field you plan to statically cross-reference, insert a valueXRef node with a unique child node name. This value will be used to identify the static field. For instance, if you plan to map between order status codes, you might create a common value of Order.Status. Within an XML configuration file you name List_Of_ValueXRef_Data.xml, insert the XML shown in Listing 2-15. Listing 2-15. List_Of_ValueXRef_Data.xml OP PD CD 1:Open 2:Pending 3:Closed For each static field you create in the List_Of_ValueXRef.xml file, insert a valueXRef node. For each system you create in the List_Of_App_Type.xml file, insert an appType node. Insert one or more appValue nodes for each value that is permissible for this valueXRef field. Insert a commonValue attribute to store the common name for the value, and set the applicationspecific value within the node. The common value will be repeated for each appType that is cross-referenced.
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Within an XML configuration file you name Setup-Config.xml, insert the XML shown in Listing 2-16. Listing 2-16. Setup-Config.xml c:\List_OF_App_Type.xml c:\List_Of_ValueXRef.xml c:\List_Of_ValueXRef_Data.xml Each node should point to the physical location where you have created the corresponding XML configuration files. Seed the BizTalk cross-reference tables by opening a command-line window and running the BizTalk cross-reference import tool, BTSXRefImport.exe (found in the BizTalk installation directory), passing in the path to the Setup-Config.xml cross-reference file: BTSXRefImport.exe --file=C:\Setup-Config.xml



How It Works During installation of BizTalk, several static cross-reference tables are created in the BizTalkMgmtDb database. All the cross-reference tables begin with the prefix xref_, and the BTSXRefImport tool imports the data from the XML files provided to the table structure for access at runtime. It is not necessary to use the BTSXRefImport.exe tool to insert data into the cross-reference tables. You may insert data directly into the following tables: • xref_AppType • xref_ValueXRef • xref_ValueXRefData In a denormalized form, the table would look like this after running the BTSXRefImport tool:



AppType



ValueXRef



CommonValue



AppValue



AppType



Oracle



Order.Status



Open



OP



Oracle



Siebel



Order.Status



Open



1:Open



Siebel



Oracle



Order.Status



Pending



PD



Oracle



Siebel



Order.Status



Pending



2:Pending



Siebel



Oracle



Order.Status



Closed



CD



Oracle



Siebel



Order.Status



Closed



3:Closed



Siebel
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2-11. Using the ID Cross-Reference Functoids Problem Within a map, you wish to dynamically cross-reference unique identifiers between two or more systems, and the identifier cross-references have already been loaded into the cross-reference tables. For example, a source system publishes an Account with a unique identifier of 1234, and you want to cross-reference and dynamically translate that identifier to the unique identifier in a destination system of AA3CARA.



■Note If you have not already loaded the identifier cross-reference data, see Recipe 2-9 for more information.



Solution In order to cross-reference the identifiers within a map, take the following steps: 1. Click the Database Functoids tab in the Toolbox. 2. Drag the Get Common ID functoid onto to the map surface. 3. Open the Input Parameters dialog box for the Get Common ID functoid. 4. Add a constant parameter and set the value to the ID type you wish to cross-reference. For instance, you may set the value to something like Customer.ID. 5. Add a second constant parameter to the Get Common ID functoid and set the value to the source system application instance. For instance, you may set the value to something like Siebel_01. 6. Click OK. 7. Connect the unique source identifier node you wish to cross-reference from the source schema to the Get Common ID functoid. 8. Drag the Get Application ID functoid from the Database Functoids tab onto the map surface and place it to the right of the Get Common ID functoid. 9. Open the Input Parameters dialog box for the Get Application ID functoid. 10. Add a constant parameter and set the value to the ID type you wish to receive. For instance, you may set the value to something like Customer.ID. 11. Add a second constant parameter to the Get Common ID functoid and set the value to the destination system application instance. For instance, you may set the value to something like Oracle_01. 12. Click OK. 13. Connect the Get Common ID functoid to the Get Application ID functoid. 14. Connect the functoid to the unique destination identifier node. 15. Save and test the map (see Recipe 2-24 for information about testing maps).
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The end result should look like Figure 2-35.



Figure 2-35. ID cross-reference map



How It Works Identifier cross-referencing allows entities to be shared across systems. Although crossreferencing functionality is often not required in small integration projects, as often there is a single system for a given entity type, in larger organizations, it is common to find several systems with the same entities (for example, Account, Order, and Invoice). These entities are often assigned a unique identifier that is internally generated and controlled by the system. In other words, from a business perspective, the entities are the same, but from a systems perspective, they are discrete. Therefore, in order to move an entity from one system to another, you must have a way to create and store the relationship between the unique identifiers, and to discover the relationships at runtime. BizTalk Server provides this functionality through cached cross-referencing tables, API, an import tool, and functoids. Using the import tool, you can load information about systems, instances of those systems, the entities within those systems you wish to cross-reference, and the actual cross-reference data into a set of cross-reference tables that are installed with BizTalk in the BizTalkMgmtDb database. Then, using the functoids or API at runtime, you access the tables to convert an identifier from one recognized value to another. The basic steps for converting from one system to another are as follows: 1. Using the source identifier, source instance, and source entity type, retrieve the common identifier by calling the Get Common ID functoid.



■Note The common identifier is commonly not stored in any system. It is an identifier used to associate one or more identifiers.



2. Using the common identifier, destination system instance, and destination entity type, retrieve the destination identifier by calling the Get Application ID functoid. This recipe has focused on accessing identifier cross-referencing functionality through BizTalk functoids, but an API is also available. The cross-referencing class may be found in the Microsoft.Biztalk.CrossRreferencing.dll, within the namespace Microsoft.BizTalk. CrossReferencing. This class has several members that facilitate storing and retrieving identifier cross referencing relationships, as listed in Table 2-1.
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Table 2-1. ID Cross-Referencing API



Member



Description



GetCommonID



With an application instance, entity/id type, and application identifier value, retrieves a common identifier. If a cross-reference does not exist, a blank will be returned. If the application instance or entity/id type does not exist, an exception will be thrown.



GetAppID



With a common identifier, application instance, and entity/id type, retrieves the application identifier value. If a cross-reference does not exist, a blank will be returned. If the application instance or entity/id type does not exist, an exception will be thrown.



SetCommonID*



With an application instance, entity/id type, application identifier value, and optionally a common identifier, create a relationship in the cross-referencing tables. If a common identifier is not passed to the method, one will be created and returned. If the application instance or entity/id type does not exist, an exception will be thrown.



* The SetCommonID method does set the common identifier, and will create one if not passed to the method, but more important, it creates the relationship between the application-specific identifier and the common identifier. Perhaps a better name would have been SetIDCrossReference.



2-12. Using the Value Cross-Reference Functoids Problem Within a map, you wish to statically cross-reference state values between two or more systems, and the value cross-references have already been loaded into the cross-reference tables. For example, a source system publishes an Order with a status of 1:Open, and you want to crossreference and translate the static state value to the static value in a destination system of OP.



■Note If you have not already loaded the value cross-reference data, see Recipe 2-10 for more information.



Solution In order to cross-reference the static values within a map, take the following steps: 1. Click the Database Functoids tab in the Toolbox. 2. Drag the Get Common Value functoid to the map surface. 3. Open the Input Parameters dialog box for the Get Common Value functoid. 4. Add a constant parameter and set the value to the static value type you wish to crossreference. For instance, you may set the value to something like Order.Status.
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5. Add a second constant parameter to the Get Common Value functoid and set the value to the source system application type. For instance, you may set the value to something like Siebel. 6. Click OK. 7. Connect the state value source node you wish to cross-reference from the source schema to the Get Common Value functoid. 8. Drag the Get Application Value functoid from the Database Functoids tab to the map surface and place it to the right of the Get Common Value functoid. 9. Open the Input Parameters dialog box for the Get Application Value functoid. 10. Add a constant parameter and set the value to the static value type you wish to crossreference. For instance, you may set the value to something like Order.Status. 11. Add a second constant parameter to the Get Common Value functoid and set the value to the destination system application type. For instance, you may set the value to something like Oracle. 12. Click OK. 13. Connect the Get Common Value functoid to the Get Application Value functoid. 14. Connect the functoid to the unique destination state value node. 15. Save and test the map (see Recipe 2-24 for information on testing maps). The end result should look like Figure 2-36.



Figure 2-36. Value cross-reference map



How It Works Identifier and value cross-referencing are similar in concept, with the following differences: • Value cross-referencing is commonly between enumeration fields. Identifier crossreferencing is commonly between entity unique identifiers. • Value cross-referencing occurs between system types. Identifier cross-referencing occurs between instances of system types. • Identifier cross-references may be set at runtime. Value cross-references are static and may be loaded only through the import tool or direct table manipulation.
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■Note For a conceptual overview of the cross-referencing functionality provided by BizTalk, see Recipe 2-9.



The basic steps for converting from one system to another are as follows: 1. Using the source application type, source application static value, and source entity value type, retrieve the common value by calling the Get Common Value functoid.



■Note The common value is commonly not stored in any system. It is a value used to associate multiple values. 2. Using the common static value, destination system type, and destination entity value type, retrieve the destination static value by calling the Get Application Value functoid. This recipe has focused on accessing value cross-referencing functionality through BizTalk functoids, but an API is also available. The cross-referencing class may be found in the Microsoft.Biztalk.CrossRreferencing.dll, within the namespace Microsoft.BizTalk. CrossReferencing. This class has several members that facilitate storing and retrieving value cross-referencing relationships, as listed in Table 2-2. Table 2-2. Value Cross-Referencing API



Member



Description



GetCommonValue



With an application type, entity/node value type, and application value, retrieves a common value. If a cross-reference does not exist, a blank will be returned. If the application type or entity/node value type does not exist, an exception will be thrown.



GetAppValue



With a common value, application type, and entity/node type, retrieves the application value. If a cross-reference does not exist, a blank will be returned. If the application type or entity/node value type does not exist, an exception will be thrown



2-13. Using the Looping Functoid Problem The structure of a message from a source system you are integrating with contains multiple repeating record types. You must map each of these record types into one record type in the destination system. In order for the message to be imported into the destination system, a transformation must be applied to the source document to consolidate, or standardize, the message structure.



Solution Create a map that utilizes the BizTalk Server Looping functoid, by taking the following steps:
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1. Click the Toolbox, and then click the Advanced Functoids tab. On the map surface, in between the source and destination schemas, drag and drop a Looping functoid. This functoid accepts 1 to 100 repeating source records (or data elements) as its input parameters. The return value is a reference to a single repeating record or data element in the destination schema. 2. Connect the left side of the Looping functoid to the multiple repeating source data elements that need to be consolidated. 3. Connect the right side of the Looping functoid to the repeating destination data element that contains the standardized data structure.



How It Works An example of a map that uses the Looping functoid is shown in Figure 2-37.



Figure 2-37. Using the Looping functoid In this example, multiple types of plane flight reservations are consolidated into a single list of records capturing passengers and their associated seats. The XML snippet in Listing 2-17 represents one possible instance of the source schema. Listing 2-17. Source Schema Instance for the Looping Functoid Example 123 Ben Lange 5A QuickTravel
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True Lauren Jones 5B QuickTravel False Meghan Stone 25E Josh HecK Sydney Oniel 12B Heathrow Based on this source XML, the looping map displayed in Figure 2-37 will produce the XML document shown in Listing 2-18, containing a single passenger seat assignment list. Listing 2-18. Destination Schema Instance for the Looping Functoid Example This example displays a simplistic but useful scenario in which the Looping functoid can be used. Essentially, this functoid iterates over the specified repeating source records (all those with a link to the left side of the functoid), similar to the For...Each structure in coding languages, and maps the desired elements to a single repeating record type in the destination schema.



■Note The four source records in the XML instance (the two OnlineReservations records, the one TravelAgentReservation record, and the one AirlineReservation record) produced four records in the



output XML. If the source instance had contained five records, the resulting output XML document would also contain five records.



Based on this simple principle, you can develop much more complex mappings via the Looping functoid. One example of a more advanced use of the Looping functoid is conditional looping. This technique involves filtering which source records actually create destination
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records in the resulting XML document. The filtering is done by adding a logical functoid to the map, which produces a true or false Boolean value based on the logic. Common examples of filtering are based on elements that indicate a certain type of source record, or numeric elements that posses a certain minimum or maximum value. The previous flight reservation example can be extended to implement conditional looping, in order to map only those online reservations that have been confirmed. This can be accomplished via the following steps: 1. Click the Toolbox, and then click the Logical Functoids tab. On the map surface, in between the source and destination schemas, drag and drop a logical Equal functoid. This functoid accepts two input parameters, which are checked for equality. The return value is a Boolean true or false. 2. Specify the second input parameter for the logical Equal functoid as a constant, with a value of true. 3. Connect the left side of the logical Equal functoid to the data element whose value is the key input for the required decision (equality, in this case) logic. 4. Connect the right side of the logical Equal functoid to the element in the destination schema containing the repeating destination data element that contains the standardized data structure. An example of the enhanced map is shown in Figure 2-38.



Figure 2-38. Conditional looping Based on the same source XML outlined earlier in Listing 2-17, the looping map displayed in Figure 2-38 will produce the following XML document, containing a single passenger seat assignment list with only three passengers (Lauren Jone’s reservation, which was not confirmed, is filtered out by the conditional looping logic):
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■Note Due to the fact that the Confirmation element is not being mapped over to the destination schema, the output of the logical Equal functoid is tied to the Passenger record. If the logical Equal functoid were being applied to an element that is being mapped to the destination schema, such as the Seat element, the output of the Equal functoid could be tied directly to the SeatNumber element in the destination schema.



In this example of conditional looping, the second input parameter of the logical Equal functoid is a hard-coded constant set to true. In real-world scenarios, it may not be ideal for this value to be hard-coded. You may prefer to have it driven off a configurable value. Several alternatives exist: • Implement a Scripting functoid to the map, which passes the name of a configuration value to an external assembly. This external assembly would then handle the “look up” of the actual configuration value. (See Recipe 2-18 for information about calling compiled assemblies from a map.) • Implement a Database Lookup functoid, which as the name implies, would look up the appropriate configuration value from a database table. (See Recipe 2-8 for information about using the Database Lookup functoid.) • Use a custom functoid, written in any .NET-compliant language. This option is similar to the external assembly route, except that it is implemented specifically as a functoid as opposed to a general .NET assembly. (See Recipe 2-15 for more information about creating a custom functoid.) When implementing a map that uses the Looping functoid, it is important to understand how BizTalk Server inherently handles repeating records in the source schema. If a record in the source schema has a Max Occurs property set to greater than 1, BizTalk Server handles the record via a loop. No Looping functoid is required in order for the map to process all appropriate source records. A Looping functoid is needed only to consolidate multiple repeating source records into a single repeating destination record.



2-14. Using the Iteration Functoid Problem You need to implement a map that handles certain records within a repeating series in an intelligent fashion. The map must be able to determine the sequential order, or index, of each repeating record, and perform customized logic based on that index.
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Solution Develop a BizTalk Server map, and leverage the Iteration functoid by taking the following steps. 1. Click the Toolbox, and then click the Advanced Functoids tab. On the map surface, in between the source and destination schemas, drag and drop an Iteration functoid. This functoid accepts a repeating source record (or data element) as its one input parameter. The return value is the currently processed index of a specific instance document (for a source record which repeated five times, it would return 1, 2, 3, 4, and 5 in succession as it looped through the repeating records). 2. Connect the left side of the Iteration functoid to the repeating source record (or data element) whose index is the key input for the required decision logic. 3. Connect the right side of the Iteration functoid to the additional functoids used to implement the required business logic.



How It Works An example of a map that uses the Iteration functoid is shown in Figure 2-39.



Figure 2-39. Using the Iteration functoid In this example, all the afternoon hourly energy values from the source XML are mapped over to the destination XML. The Iteration functoid is used to determine the index of each HourlyUsage record, with those having an index value of 13 or higher being flagged as afternoon hours. Additionally, the output from the Iteration functoid is also used to create the HourEnding element in the destination XML, defining to which hour the energy reading pertains. The XML snippet in Listing 2-19 represents one possible document instance of the source schema (the first 12 HourlyUsage XML records have been omitted for simplicity).
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Listing 2-19. Sample Source Instance for the Iteration Functoid Example 05/21/2006 ... 12 HourlyUsage records omitted ... 2.4 0 2.5 0 2.8 0 3.0 0 2.9 0 2.8 0 2.5 0 2.3 0 2.3 0 2.0 0 
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1.7 0 1.5 0 When passed through the map displayed in Figure 2-39, this XML will produce the XML document shown in Listing 2-20, containing all the afternoon hourly energy usage values with their associated HourEnding value. Listing 2-20. Sample Destination Instance for the Iteration Functoid Example 05/21/2006 13 2.4 14 2.5 15 2.8 16 3.0 17 2.9 18 2.8 19 2.5 
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20 2.3 21 2.3 22 2.0 23 1.7 24 1.5 The Iteration functoid can be a crucial tool for those business scenarios that require the current index number of a looping structure within a map to be known. In the energy usage example, it allows a generic list of chronological usage values to be mapped to a document containing only those values that occur in the afternoon, along with adding an element describing to which hour that usage pertains. As the map processes the repeating HourlyUsage records in the source XML in a sequential fashion, the index from the Iteration functoid is passed to the logical Greater Than functoid, which compares the index with a hard-coded value of 12. If the index value is 13 or greater, the element is created in the destination XML, and its hour ending value is set. This example works well for the purposes of our simple scenario, but those who have dealt with hourly values of any kind know that days on which daylight saving time (DST) falls need to be handled carefully. Since the time change associated with DST actually occurs early in the morning, there are 13 morning (pre-afternoon) hourly values in the fall occurrence of DST, and 11 morning hourly values in the spring occurrence. The map in Figure 2-39 can easily be enhanced to account for this by adding logic based on the record count of hourly values in the source XML document. You can accomplish this via the following steps: 1. Click the Toolbox, and then click the Advanced Functoids tab. On the map surface, in between the source and destination schemas, drag and drop a Record Count functoid. This functoid accepts a repeating source record (or data element) as its one input parameter. The return value is the count of repeating source records contained in a specific instance document. 2. Connect the left side of the Record Count functoid to the repeating source record (or data element) whose index is the key input for the required decision logic.
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3. Drag and drop a Subtraction functoid from the Mathematical Functoids tab onto the map surface, positioning it to the right of the Record Count functoid. This functoid accepts a minimum of 2 and a maximum of 99 input parameters. The first is a numeric value, from which all other numeric input values (the second input parameter to the last) are subtracted. The return value is a numeric value equaling the first input having all other inputs subtracted from it. 4. Connect the right side of the Record Count functoid to the left side of the Subtraction functoid. 5. Specify the second input parameter for the Subtraction functoid as a constant, with a value of 12. 6. Connect the right side of the Subtraction functoid to the left side of the Greater Than functoid. Ensure that this input to the Greater Than functoid is the second input parameter. Figure 2-40 shows an example of this enhanced map.



Figure 2-40. DST map In this modified example, the repeating source record’s count has 12 subtracted from it to adjust for the two DST days of the year (this works since we are interested in only the afternoon energy usage values, which are always the final 12 readings for a day). This adjusted value is then passed through the same logical Greater Than functoid as in the previous example, and the DST issue is effectively handled. The use of the Iteration functoid is common in a number of other scenarios. One such scenario is when dealing with a document formatted with comma-separated values (CSV). Often, the first row in a CSV document contains column header information, as opposed to actual record values. The following flat file snippet shows one possible representation of energy usage values in CSV format:
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EnergyUsage,Adjustments 2.4,0 2.5,0 2.8,0 In cases like these, it is likely that you do not want to map the column headers to the destination XML document. You can use an Iteration functoid to skip the first record of a CSV document. The index from the Iteration functoid is passed to a logical Not Equal functoid, which compares the index with a hard-coded value of 1. If the index is anything other than 1 (the record at index 1 contains the column header information), the values are mapped to the destination XML. See Recipe 1-10 for more information about CSV files.



■Note You can also strip out column headers by using envelope schemas. See Recipe 1-7 for more information.



Another common use of the Iteration functoid is to allow the interrogation of records preceding or following the currently processed record. This can be helpful when mapping elements in a repeating record in the source schema that require knowledge of the next or previous record.



2-15. Creating a Custom Functoid Problem You have a mapping need that requires the repeated use of complex functionality.



Solution Rather than writing the same inline code (C#, XSLT, and so on) and pasting it in multiple shapes, or using a combination of multiple existing functoids, you can develop your own custom functoid. As an example, we’ll describe the process to develop, deploy, and use a custom functoid that replaces the ampersand (&), greater than (>), and less than ( 
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